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EEDDIITTOORRIIAALL

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE!

The usual LibreOffice, Blender, and Inkscape HowTo's are here, but Greg has had to
take this month off. Replacing your regular Python article is an interesting piece on

automating Gpodder to become your personal entertainment assistant. Give that a try.
And, while you're at it, you can try hooking up to the Internet using IPV6 in this month's
other HowTo.

A new addition to Full Circle is the Software Showdown. Each month, Tushar will
have similar applications compete against each other to see who will come out on top.
This month: PDF viewers.

Ubuntu Women has the story of a school which completely switched to Ubuntu and
if you enjoyed last month's Linux Lab article about DVD video, then this month's article
should tickle your fancy too. This time Charles discusses creating DVD menus.

Gord has tweaked his Q&A column to include links to the most popular questions
from AskUbuntu.com. This is something quite a lot of you asked for in the survey.

Now is the best time to submit a shot of your desktop for the My Desktop section as
I am now officially out of screens. If you fancy submitting your desktop for others to
see, please read the info on the penultimate page of this issue.

All the best, and keep in touch!
Ronnie

ronnie@fullcirclemagazine.org

This magazine was created using :

Full Circle Podcast
Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark

http://fullcirclemagazine.org

mailto:ronnie@fullcirclemagazine.org
http://www.scribus.net
http://www.gimp.org
http://www.libreoffice.org
http://creativecommons.org/
http://fullcirclemagazine.org
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UUBBUUNNTTUU NNEEWWSS
Written by The Ubuntu News Team

MARK SHUTTLEWORTH

CLOSES UBUNTU BUG #1

Mark Shuttleworth closes
Ubuntu bug #1 with

following words: “Personal
computing today is a broader

proposition than itwas in 2004:

phones, tablets, wearables and

otherdevices are all partofthemix

forourdigital lives. From a

competitive perspective, that

broadermarkethas healthy

competition, with IOSandAndroid

representing ameaningful

share...Even though we have only

playeda small part in that shift, I

think it’s importantforus to

recognize that the shifthas taken

place. So from Ubuntu’s perspective,

this bug is nowclosed."
Full remarks at:
http://fridge.ubuntu.com/2013/05/
31/mark-shuttleworth-closes-
ubuntu-bug-1/
Want more on the closure of bug
#1? Several news sites blogs
covered it, here’s a sampling of
what they had to say:
Mark Shuttleworth closes the
2004's bug #1 due to today's

realities -
http://www.iloveubuntu.net/mark-
shuttleworth-closes-2004s-bug-1-
due-todays-realities

Mark Shuttleworth Marks Bug #1,
‘Microsoft Has Majority
Marketshare, As Fixed -
http://www.omgubuntu.co.uk/201
3/05/mark-shuttleworth-marks-
bug-1-fixed

Ubuntu bug #1 marked as fixed by
Mark Shuttleworth -
http://www.webupd8.org/2013/05
/ubuntu-bug-1-marked-as-fixed-by-
mark.html

Ubuntu declares bug #1 --
'Microsoft has a majority market
share' -- closed -
http://www.zdnet.com/ubuntu-
declares-bug-1-microsoft-has-a-
majority-market-share-closed-
7000016129/

Mark Shuttleworth closes Ubuntu’s
Bug No. 1 now that Microsoft’s
hold on computing is declining -
http://blogs.dailynews.com/click/2
013/05/30/mark-shuttleworth-
closes-ubuntus-bug-no-1-

microsofts-hold-computing-
declining/

Ubuntu Marks 'Bug No. 1' As Fixed,
After Nearly Nine Years -
http://www.npr.org/blogs/thetwo-
way/2013/05/30/187318344/ubunt
u-marks-bug-no-1-as-fixed-after-
nearly-nine-years

COMMUNITY ON

UBUNTU.COM

Daniel Holbach announces the
launch of

http://community.ubuntu.com,
which “is the primaryaddress for
interestedUbuntu users to stay

involvedandget informedabout

whatourcommunity is doing.”
http://fridge.ubuntu.com/2013/05/
31/community-on-ubuntu-com/

MARK SHUTTLEWORTH:
HERE COMES THE CARRIER

ADVISORY GROUP

Mark Shuttleworth announces
that the first meeting of the

Ubuntu Carrier Advisory Group has
taken place to help “figure outhow
best to shapeUbuntu to meet the

needsofthemobile industry.” Of
the meeting itself, Shuttleworth
also writes: “Wemappedoutour

approach to the keyquestion I’ve

been askedbyeverycarrierwe’ve

met so far: howcan we

accommodate differentiation,

withoutfragmenting the platform

fordevelopers?Wedescribedthe

range ofdiversitywe thinkwe can

support initially, receivedsome

initial feedbackfrom carriers

participating immediately, andI’m

looking forwardto the distilled

feedbackwe’ll geton the topic in

the nextcall.”
http://www.markshuttleworth.com
/archives/1261
Canonical’s announcement:
“Formation of Carrier Advisory
Group for Ubuntu mobile
development” -
http://www.canonical.com/content
/formation-carrier-advisory-group-
ubuntu-mobile-development
Finally, several news outlets and
other blogs have covered this
news, here’s a sampling selected
by our editors:

http://fridge.ubuntu.com/2013/05/31/mark-shuttleworth-closes-ubuntu-bug-1/
http://www.iloveubuntu.net/mark-shuttleworth-closes-2004s-bug-1-due-todays-realities
http://www.omgubuntu.co.uk/2013/05/mark-shuttleworth-marks-bug-1-fixed
http://www.webupd8.org/2013/05/ubuntu-bug-1-marked-as-fixed-by-mark.html
http://www.zdnet.com/ubuntu-declares-bug-1-microsoft-has-a-majority-market-share-closed-7000016129/
http://blogs.dailynews.com/click/2013/05/30/mark-shuttleworth-closes-ubuntus-bug-no-1-microsofts-hold-computing-declining/
http://blogs.dailynews.com/click/2013/05/30/mark-shuttleworth-closes-ubuntus-bug-no-1-microsofts-hold-computing-declining/
http://www.npr.org/blogs/thetwo-way/2013/05/30/187318344/ubuntu-marks-bug-no-1-as-fixed-after-nearly-nine-years
http://community.ubuntu.com
http://fridge.ubuntu.com/2013/05/31/community-on-ubuntu-com/
http://www.markshuttleworth.com/archives/1261
http://www.canonical.com/content/formation-carrier-advisory-group-ubuntu-mobile-development
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UBUNTU NEWS
Ubuntu phone OS has eight
carriers signed on to boost
development -
http://arstechnica.com/informatio
n-technology/2013/06/ubuntu-
phone-os-has-eight-carriers-
signed-on-to-boost-development/

Ubuntu Carrier Advisory Group
Announced -
http://www.jonobacon.org/2013/0
6/18/ubuntu-carrier-advisory-
group-announced/

Canonical announces Ubuntu
Carrier Advisory Group with LG
UPlus, Telecom Italia, Korea
Telecom, Deutsche Telekom, etc,
as members
-http://www.iloveubuntu.net/cano
nical-announces-ubuntu-carrier-
advisory-group-lg-uplus-telecom-
italia-korea-telecom-deutsche

8 Major Mobile Carriers Join
Ubuntu Touch Advisory Group -
http://www.omgubuntu.co.uk/201
3/06/8-mobile-operators-give-
backing-to-ubuntu-touch

Canonical's Ubuntu for
smartphones gets support from
eight mobile operators -
http://www.theinquirer.net/inquir
er/news/2276104/canonicals-
ubuntu-for-smartphones-gets-

support-from-eight-mobile-
operators

Canonical unveils Carrier Advisory
Group for Ubuntu phones -
http://www.theregister.co.uk/2013
/06/18/ubuntu_carrier_advisory_b
oard/

UBUNTU DONATIONS AND

COMMUNITY FUNDING

Specific details about Ubuntu
Donations and Community

Funding have been announced
following a plan prepared by Jono
Bacon and approved by the
Community Council. Donation
periods will occur every 6 months,
and the money received in the
previous cycle will go to fund the
current cycle. Those wishing to
apply for funding must submit a
form, and it cannot be used for an
arbitrary amount of money for a
person or a team. A report
containing the budget, a list of
items where the money was spent,
and the remaining balance will be
released at the end of the cycle.
http://fridge.ubuntu.com/2013/06/
20/ubuntu-donations-and-
community-funding/

IMPROVING WEB SERVICES

FOR UBUNTU

In an effort to improve web
services and help address issues

from user testing, various services
like Ubuntu Single Sign On and
Ubuntu Pay are being re-branded
under the Ubuntu One name.
Information from the various
services will soon be available from
the same place in order to relieve
some confusion. Along with the re-
branding comes an improved
design and a new user interface.
http://fridge.ubuntu.com/2013/06/
21/improving-web-services-for-
ubuntu/

WELCOME NEW MEMBERS

AND DEVELOPERS

At the Developer Membership
Board meeting on 2013-06-03

the following individuals joined
MOTU:
Matt Fischer -
https://wiki.ubuntu.com/MattFisch
er | https://launchpad.net/~mfisch
Dmitry Shachnev -
https://wiki.ubuntu.com/DmitrySh
achnev
https://launchpad.net/~mitya57
https://lists.ubuntu.com/archives/u

buntu-news-team/2013-
June/001815.html

Many Thanks to the Ubuntu News
Team for their contribution this
month.

News this month comes from:

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue319

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue320

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue321

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue322

http://arstechnica.com/information-technology/2013/06/ubuntu-phone-os-has-eight-carriers-signed-on-to-boost-development/
http://www.jonobacon.org/2013/06/18/ubuntu-carrier-advisory-group-announced/
http://www.iloveubuntu.net/canonical-announces-ubuntu-carrier-advisory-group-lg-uplus-telecom-italia-korea-telecom-deutsche
http://www.omgubuntu.co.uk/2013/06/8-mobile-operators-give-backing-to-ubuntu-touch
http://www.theinquirer.net/inquirer/news/2276104/canonicals-ubuntu-for-smartphones-gets-support-from-eight-mobile-operators
http://www.theinquirer.net/inquirer/news/2276104/canonicals-ubuntu-for-smartphones-gets-support-from-eight-mobile-operators
http://www.theregister.co.uk/2013/06/18/ubuntu_carrier_advisory_board/
http://fridge.ubuntu.com/2013/06/20/ubuntu-donations-and-community-funding/
http://fridge.ubuntu.com/2013/06/21/improving-web-services-for-ubuntu/
https://wiki.ubuntu.com/MattFischer | https://launchpad.net/~mfisch
https://wiki.ubuntu.com/DmitryShachnev
https://launchpad.net/~mitya57
https://lists.ubuntu.com/archives/ubuntu-news-team/2013-June/001815.html
https://lists.ubuntu.com/archives/ubuntu-news-team/2013-June/001815.html
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue319
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue320
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue321
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue322
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When going through last
month's survey results, I was

pleasantly surprised to see a
number of interesting suggestions,
and what seemed to be an overall
positive response to C&C.
However, I also noticed a few
suggestions and requests for
topics I have already covered. As
such, I decided I'd devote this
article to directing those to the
past issues, and to also answer
some of the quicker questions that
were aimed in my direction.

LaTeX: I covered this in C&C in
FCM#50 and #52 – where 52 was
aimed more at Asian languages in
LaTeX.

Virtualbox: Someone asked for
advice on how to install Virtualbox
in Ubuntu 12.04 because they were
having issues. I had a short-lived
virtualization series in FCM#38-45,
but the short answer is, go to this
web page:
https://www.virtualbox.org/wiki/D
ownloads

Install the current version of
VirtualBox for Linux hosts, then

the Extension Pack. You have to
select the VirtualBox package
which corresponds to the version
of Ubuntu you are using, and 32-bit
or 64-bit.

Automation: A surprising
number of you seemed to be
interested in writing bash scripts
to automate things (either for
yourself or for family members). I
introduced that topic in C&C in
FCM#24, but judging by the
response, I'll probably be writing
another few articles on that at a
later date.

Conky: There were a fair
amount of requests on getting
started with conky. I have covered
Conky in the following issues of
FCM (in the C&C column): #44,
#45,#46, #48, #51. If you have any
particular issues with Conky, feel
free to email me about it at
lswest34@gmail.com. Please put
“conky question” in the subject,
and include the output of both
lsb_release -a and conky -v

IDEs: Someone asked for a
review of IDEs – without knowing

exactly what languages you want
to develop for, it would be a fairly
confusing article. That being said, I
did discuss IDEs in FCM#64.

CLI Coloring: A couple of
people asked about styling your
prompt and terminal. I have
discussed this in FCM#27, #35, #36

Command-line “cookbook”:
Someone asked for a collection of
useful command combinations and
I thought it might be interesting to
open this up to the readers. If you
have a favourite command (or ones
you simply find yourself using a
lot), feel free to add them to this
google doc here: goo.gl/fp09r –
please include why the command is
useful (i.e. what you use it for).
Once we have a list of sufficient
length, I'll go through the
commands and compile it into an
article “cookbook”.

And now, on to some questions
that were fairly brief and would
not have been enough for a whole
article in and of themselves.

Create a folder hierarchy with a

one-liner (Bash scripts): First off,
this doesn't require a script of any
sort. Mkdir (make directory) is the
command-line tool Linux offers for
this. Usually it will create only a
single folder at a time; if you tell it
to create a path, it will fail.
However, it has a command-line
argument “-p” (how I remember
this is p=path, so make path,
instead of directory), which does
exactly what you want. Take this
scenario, for example: You want to
create a folder Summer in your
Pictures folder, with two folders
within it called Tahiti and Montreal.
This can be done with one single
command:

mkdir -p
Pictures/Summer/{Tahiti,Montr
eal}

The -p argument will literally
create directories as needed to
reach the directories you want to
create. So if Pictures or Summer
(or both) are missing, they will be
created. The only caveat is that you
can't put spaces between the
commas. You can certainly make
names with spaces though, as you
can see below:

CCOOMMMMAANNDD && CCOONNQQUUEERR
Written by Lucas Westermann

SSuurrvveeyy RReessuullttss

https://www.virtualbox.org/wiki/Downloads
mailto:lswest34@gmail.com
http://goo.gl/fp09r
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Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.

mkdir -p
Pictures/Summer/{“Tahiti
2013”,”Montreal 2012”}

As you can see, you can't place a
space between the items and the
comma (mkdir understands it as
two paths then:
Pictures/Summer/{Tahiti 2013 and
./Montreal 2012} – as you can tell,
they won't even end up in the
same folder). Naturally, this also
works on Mac OS X systems, as
they offer the typical mkdir
command.

Another question I had was to
create a bash script to
automatically mount a second and
third hard drive. Once again, this
isn't a Bash problem. Linux offers
you a configuration file called
/etc/fstab. This is in charge of
mounting all your drives on boot-
up. It will look something like that
shown below.

The following mounts an NTFS
drive to /media/Windows while
giving permission to access it to

the user lswest and all users in the
group users. Edit the uid and gid as
you see fit. You'll also need to
change /dev/sda5 to the correct
partition:

/dev/sda5
/media/Windows ntfs-3g
uid=lswest,gid=users,dmask=02
2,fmask=133
0 0

Example of mounting a FAT32
USB stick using UUID – again,
change the UUID to the correct
one:

UUID=47FA-4071
/home/lswest/USB vfat
defaults,noatime 0 0

If you want to use spaces in the
paths, you need to replace the
spaces with \040 in the file. Once
you edit /etc/fstab, you can test to
see if it's working by running:

sudo mount -a

If the drives show up where you
expect, and you can access them,
you're all set. You can check UUIDs
by running:

sudo blkid

Or, if you want the UUID for a
single drive/partition, you can use:

sudo vol_id –uid /dev/sda2

Replace, of course, sda2 with
the actual drive you want.

Lastly, there were a few
requests for covering GRUB2.
While that would be an article in
itself, I felt I should at least offer a
little bit of information for those
who don't want to wait. For GUI-
based editing of some settings,
there's grub-customizer:
https://launchpad.net/grub-
customizer

If you're just after a different
theme, they are discussed at the
following links:

https://help.ubuntu.com/communi
ty/Grub2

http://askubuntu.com/questions/6
6183/how-can-i-get-some-nice-eye-
candy-themes-for-grub

https://help.ubuntu.com/communi
ty/Grub2/Displays

Hopefully I've answered the
questions sufficiently. If anyone
has any further questions, feel free
to email me at
lswest34@gmail.com. Please
include “C&C” or “FCM” in the
subject line. If anyone has any
suggestions for topics I should
cover, you're also more than
welcome to email me about them.
Judging by the survey, it seems a
great deal of you have suggestions
or questions. The problem with
some is that they are too specific
for an actual article – but if you
email me I can probably set you on
the right path to fixing it.

COMMAND & CONQUER

# <file system> <dir> <type> <options> <dump> <pass>
/dev/sda1 / ext4 defaults,noatime 0 1
/dev/sda2 none swap defaults 0 0
/dev/sda3 /home ext4 defaults,noatime 0 2

mailto:lswest34@gmail.com
mailto:lswest34@gmail.com
mailto:lswest34@gmail.com
https://launchpad.net/grub-customizer
https://help.ubuntu.com/community/Grub2
http://askubuntu.com/questions/66183/how-can-i-get-some-nice-eye-candy-themes-for-grub
https://help.ubuntu.com/community/Grub2/Displays
mailto:lswest34@gmail.com
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HHOOWW--TTOO
Written by Neal Bailey GGppooddddeerr:: YYoouurr EEnntteerrttaaiinnmmeenntt AAssssiissttaanntt

Podcasting has revolutionized
the way we create, share, and

distribute content over the
Internet. Nearly everyone is aware
of programs such as Apple's
iTunes, and most people are aware
of some of the various open source
podcatching alternatives. Several
of these applications provide ways
to download episodes on a
schedule, however, for the most
part, these programs usually
download every episode of every
subscribed podcast. Many people
subscribe to far more shows than
they could ever actually have time
to listen to.

We will introduce a system to
download only the specific
podcasts we listen to regularly.
Our solution will convert video
podcasts to audio MPEG-3, so all of
our episodes are ready to be
copied to a CD, MP3 player, or
similar device.

SETUP GPODDER

Gpodder is the podcatching
software we will use to manage

our subscriptions. The first step is
to install gpodder (which should
install the package we really want,
gpodder-cli), so we can convert
video podcasts to MP3 audio.

sudo apt-get install gpodder
lame

When you run gpodder for the
first time you will be prompted to
subscribe to podcasts, import an
opml file, or sync with your
gpodder.net account.

I recommend creating a
http://gpodder.net account

because it allows you to subscribe
to podcasts from a friendly
website interface and, more
importantly, it allows you to sync
all your subscriptions to multiple
computers.

SET UP FFMPEG

One of the core features of our
setup includes the ability to
extract the audio from video
podcasts so, when each download
completes, we are left with a set of
MPEG-3 audio files which can then
be synchronized with our portable

devices (or burned onto CDs for
the car). You may want to get the
most recent version of ffmpeg.
Typically this will require compiling
ffmpeg from source.

Please refer to this howto for
compiling ffmpeg:
https://ffmpeg.org/trac/ffmpeg/wi
ki/UbuntuCompilationGuide

Or, you could install ffmpeg
from the Software Center or using
Synaptic.

MANUALLY TESTING THE

SETUP

Before we go about creating
the bash script and cron job to
download and convert our
podcasts, we want to run some
manual tests to ensure the
machine is properly prepared. We
have subscribed to EpicBattleCry, a
video games podcast from the
guys at
http://www.gametrailers.com.
Enter the following commands into
the bash shell (skip lines that begin
with # as these are comments)

http://gpodder.net
https://ffmpeg.org/trac/ffmpeg/wiki/UbuntuCompilationGuide
http://www.gametrailers.com
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HOWTO - GPODDER
# update and download
podcast

# enter these 2 lines into
the bash shell

URL=http://www.gametrailers.c
om/gteba_podcast.xml

gpo update $URL && gpo
download $URL

You should see the latest
episodes getting updated and
downloaded.

This specific podcast is a video
podcast, which obviously won't
work on a CD player or standard
MP3 player, so we need to extract
and encode the audio stream from
the MP4 video file.

# extract audio from video
file and convert to MPEG-3

# change the file name to
match a file that was
downloaded in the previous
step

DLFILE=$HOME/gpodder-
downloads/"EpicBattleCry -

GameTrailers.com"/skirmish--
186---i-want-to-bite-it.mp4

# run ffmpeg

ffmpeg -i $DLFILE -vn -ac 2
-ab 192k "$DLFILE.mp3"

AUTOMATING THE SYSTEM

At this stage we have installed
gpodder (gpodder-cli) and ffmpeg,
and we used the gpodder user
interface to subscribe to a podcast.
We then updated and downloaded
the newest episodes from the
command line. Finally we used
ffmpeg to extract the MPEG-3
audio stream from the MPEG-4
video podcast.

Obviously, performing these
tasks at the terminal is
cumbersome and time consuming.
Next up we are going to automate
the solution so these tasks occur

on their own, based on a schedule.

GPODDER-SYNC

When we are all done with our
script, it will look like the image
below. Before we can get here
though, we'll need to set up the
configuration and modify the
gpodder settings.

CONFIGURATION

Create a new file called auto-

downloads.confand place it where
you like. In my setup, it is located in
$HOME/Downloads/Podcasts/

In this file, paste the Internet URL
addresses of each of the shows
that you want to auto-update (one
per line).

These podcasts can be video or
audio podcasts. If they are video
podcasts then our script will
convert them to audio podcasts for
you.

At present, the script handles
only MP3 and MP4 files. For the
podcasts I download, these appear
to be the standard file-types in
use. The script can be easily
modified to handle more file-types
if necessary.

SCRIPT

Download the bash script here:
http://pastebin.com/xyxBMhZ8,
and copy into your home or ~/bin
directory. Open the script in your
editor of choice and replace the
following values to match your
system.

LOG

This is the path and filename to
write log messages to. You can
change it if you don't want to log
to /tmp

http://pastebin.com/xyxBMhZ8
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HOWTO - GPODDER
log="/tmp/$(date +%Y-%m-
%dT%H:%M)-podcast-
download.log"

DEFS

This is the file containing the
URLs of the podcasts to
automatically download. This file
must exist prior to running the
script.

defs="$HOME/Downloads/Podcast
s/auto-download.conf"

PODDOWNLOAD

This is the path where gpodder
is configured to download. It is
usually ~/gpodder-downloads
unless you manually changed this
value in the Preferences > Edit
Config button in gpodder. On my
machine, I have changed the
default gpodder download path
(to the path you see below)

podDownload="$HOME/Downloads/
Podcasts/gpodder-downloads"

PUBDIR

This is the path to copy
downloaded and/or converted
podcasts to. It is created if it
doesn't already exist.

pubDir="$HOME/Downloads/Podca
sts/_converted"

HISTFILE

This is the path to the file used
to record which shows have
already been downloaded or
converted. It is created if it doesn't
already exist.

histFile="$HOME/Downloads/Pod
casts/_converted/_history.txt
"

TEST THE SCRIPT

Now that we have updated the
script, we need to test that it’s
working correctly.

# make it executable

chmod +x ~/bin/gpodder-
sync.sh

# run the script

cd ~/bin && ./gpodder-sync.sh

Hopefully the script updated
your specified podcasts and then
downloaded (and converted if
applicable) them to your pubDir
folder.

DOWNLOAD SCHEDULING

Now that our script is running
and everything is set up, we need
to create a scheduled task so the
script is run automatically once a
day. In the example below, we are
running the script every morning
at 10:30 am.

# open crontab

crontab -e

# enter this line into the
crontab (replace neal with
your username)

30 10 * * *
/home/neal/bin/gpodder-
sync.sh

NEXT STEPS

This process is ideal on a
headless server. I've been running
this script for a few years now on a
Ubuntu server. In this
configuration you can set the
pubDir to a SAMBA share. Now
everyone in the house can sync
their devices to the shared folder.

Feel free to send me feedback
or questions. I hope you enjoyed
this tutorial.

Neal is a software engineer and
enterprise services consultant for an
international PC firm. He has been
using Linux since 1998 as a hobbyist,
and loved every minute of it. He can
be reached by email at
nealbailey@hotmail.com

http://www.thedesignatedgeek.net
mailto:nealbailey@hotmail.com
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The LibreOffice Draw module is
a vector graphics application

included in the LibreOffice suite.
Draw lets you create graphics you
can use in your documents. While
there are more advanced vector
graphics programs – such as
Inkscape – Draw provides you with
more tools than most drawing
packages included in other office
suites.

Vector graphics create images
by defining geometric shapes such
as circles, rectangles and polygons,
rather than by pixel points on the
screen. Because of this, vector
graphics scale without distortion.

As with the other modules in
LibreOffice, Draw integrates well
with the others, making it the tool
of choice when creating graphics
for your documents.

THE DEFAULT LAYOUT

The default layout for Draw is
rather sparse. You will probably
want to modify it to include the
toolbars you use most often. The
layout includes the basic elements

you need to create a graphic
image. The center of the screen is
the area where you will create your
graphic. To the right, you have the
page pane, showing the different
pages of the graphic. Multi-page
graphics are used mostly for
presentations, and I will cover
them at a later time.

By default, you have three
toolbars. The standard toolbar is
the topmost toolbar. This is the
toolbar you see in most of the
LibreOffice modules. It controls
the new, open, save, copy, cut,
paste, and other functions that
pertain to most modules. The line

and fill toolbar sits below it. This
toolbar controls how the lines and
fill of an object will look. At the
bottom of the window sits the
drawing toolbar. From this toolbar,
you can create most of the objects
for your graphic. You can move the
toolbars by grabbing the handle at
the beginning of the toolbar and
dragging it to the location where
you want it.

The status bar at the bottom of
the window gives you a lot of
useful information about the
object you are editing. An object’s
type, dimensions, angle, and other
useful information will show up

here. I will refer to the status bar
often during the How-tos on Draw.

At the top and along the left
edge sit the rulers. The rulers are
guides to where you are in the
image. If you want to change the
unit of measure in the rulers, you
can right-click the ruler and select
a different unit of measure. When
you have an object selected, the
ruler shows double lines to
indicate the object’s position on
the drawing.

THE COLOR BAR

The color bar displays the
current color palette under the
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drawing area. You can use it to
select colors for your objects
rather than having to use the
dropdown list in the line and fill
toolbar. The first box – the white
box with an X in it – is the no color
(or invisible) selection. To display
the color bar, go to View >
Toolbars > Color Bar. To use the
color bar, left-click the color you
want for the fill color of the object,
and right-click to select the line
color.

TEAR-OFF TOOLBARS

Many of the icons on the
toolbars have a triangle or arrow
to the right. This indicates the item
is expandable. Clicking on the
arrow gives you more choices. You

can detach these items from the
toolbar, creating a floating toolbar.
When you expand the item, you
will see a grab bar at the bottom.
Click and drag the grab bar to
create a floating toolbar of the
items. This is helpful when you
need to use the items repeatedly,
and is quicker than having to
expand the items each time. When
you are finished, just close the
floating toolbar by clicking on the
close button in the title bar.

GRID, SNAP LINES, AND

SNAP POINTS

When creating an image, I find
it useful to have guides to work
from. The grid, snap lines, and snap
points are useful for such guides.

You can set the program to snap to
these guides, which help you
precisely place your objects in the
drawing.

To set up the grid, go to Tools >
Options > LibreOffice Draw > Grid.
If you want objects to snap to the
grid by default, check the Snap-to-
grid checkbox under grid. You also
have the option to make the grid
visible by default. Resolution sets
the vertical and horizontal settings
for the grid. Subdivision sets the
number of markers between the
horizontal and vertical grid points.
The more subdivisions the more
precise the changes when snap-to-
grid is on. But like most things, a
happy medium is usually better

than too much. You can set certain
snap options on by default under
the snap section, but I recommend
leaving these all off by default,
and using the options toolbar
when you need to turn them on.
Use the snap range to control how
close to a snap point you are
before your object snaps to the
point.
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Unlike the grid, snap points and
snap lines are inserted when you
need a more exact location. Snap
lines are great for aligning objects
vertically or horizontally. To create
a snap line or point, Insert > Insert
Snap Point/Line from the menu
bar. The X position controls the
distance from the left of the
image. The Y position controls the
distance from the top. The type
controls whether you are inserting
a snap point, vertical snap line, or
horizontal snap line. You can also
create snap lines by clicking and
dragging from either the
horizontal or vertical rulers. To
delete a snap line, click and drag it
back to the ruler. To delete a snap
point, right-click the snap point
and select Delete Snap Point.

OPTIONS TOOLBAR

The options toolbar contains all
your snap options. If it is not
showing, select View > Toolbars >
Options. On the toolbar, you can

toggle whether your guides are
displayed, and toggle on and off
the snap options. You might want
to dock this toolbar to the bottom
or side of your window as I suspect
you will use it often to toggle
these options.

There is one more guide on the
toolbar we have not discussed yet.
It is the helplines. When you select
the helplines on the options
toolbar, then, when you move an
object, dashed lines appear from
the corners of your object to the
rulers. The helplines are just one
more tool to help you accurately
place your objects.

CONCLUSION

LibreOffice Draw is the graphics
application of the LibreOffice
suite. Draw saves graphics in a
vector graphic format for use in
your documents created with
other applications in the suite.
Draw provides you with the tools

to combine text and geometric
objects to create your graphics.
Guides, and the ability to snap to
the guides, help you to precisely
place your objects.

In the next LibreOffice How-To,
we will look at creating basic
objects in Draw.

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.

The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org

http://podcast.ubuntu-uk.org/
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The 2008 Beijing Summer
Olympics brought IPv6 to the

attention of the technical crowd,
with further reminders on World
IPv6 Day, 8 June 2011, and World
IPv6 Launch Day, 6 June 2012. We
are, for the most part, informed
that the current IP (IPv4) address
space is running out, and that
sometime in the short to middle
term we will need to get to using
IPv6 addresses and connectivity to
the Internet.

This is not quite yet the case for
most people. Internet Service
Providers have not rolled out
native IPv6 access in many
countries. Most servers still have
only Pv4 access, with the exception
of Internet giants such as Google,
Facebook and several others. Much
of the hardware available
(specially in the domestic
category) still handles only IPv4.
But things are changing, and we
will need to get to it. Going dual-
stack, i.e. having both IPv4 and
IPv6 activated at the same time, is
a nice way of making the
transition.

Luckily for us, Debian, Ubuntu
and most other GNU/Linux
distributions are well up to speed
as regards IPv6. The Linux kernel
itself handles IPv6 quite well, GNU
user-land applications have been
adapted or ported to IPv6, and
most widely-used GUI programs
are now capable of making use of
IPv6 connections - actually, when
both IPv6 and IPv4 are present,
they tend to prefer IPv6.

So, in a way, Ubuntu is ideal to
make a first contact with this new,
IPv6-enabled version of the Web.

CONNECTING TO THE

INTERNET WITH IPV6

Supposing we do not have a
native connection to the IPv6-
enabled Internet, we shall need
the services of a tunnel broker.
This is the equivalent of an
Internet Service Provider, but
instead of giving access to the
Internet for individual lines or
devices, it gives access to the IPv6-
enabled Internet starting from a
normal IPv4 address. We will be

creating an IPv6 tunnel from our
computer to the tunnel broker,
through the IPv4-only fabric that
lies between us.

Several tunnel brokers are
available, both free and
commercial. Two in the former
category are SixXS
(http://www.sixxs.net) and Gogo6
(http://www.gogo6.com). In both
cases, the necessary software is
open, free, and readily available
from the Ubuntu repositories.

For Gogo6, we need to sign up
for their Freenet6 IPv6 access
service, at
http://www.gogo6.com/freenet6/a
ccount. Each of their servers works
independently from the others, so
remember which one you are on
(choose the one you think is best
accessible from your country).
Once we have confirmation of
being registered, we need to
install the software:

sudo apt-get install gogoc

Naturally, we could also use a
graphical program such as

Synaptic, Ubuntu Software Center,
or Muon.

We then need to edit the
configuration file
/etc/gogoc/gogoc.conf with the
username and password the server
gave us, and restart the service
with

/etc/init.d/gogoc restart

We should then be able to see
the tunnel with the ifconfig
command:

ifconfig

tun Link encap:UNSPEC
HWaddr 00-00-00-00-00-00-00-
00-00-00-00-00-00-00-00-00

inet6 addr:
2001:db8::101/128
Scope:Global

UP POINTOPOINT
RUNNING NOARP MULTICAST
MTU:1280 Metric:1

In this example, our IPv6
address would now be
2001:db8::101 . Since this is just an
example, I chose a (relatively)
simple address—real IPv6
addresses may need be written
with up to 32 hexadecimal digits,

http://www.sixxs.net
http://www.gogo6.com
http://www.gogo6.com/freenet6/account
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grouped into eight four-digit
groups.

If we choose SixXS as our tunnel
broker, the registration process
may be slightly slower (it took
slightly less than an hour for me)
since it is not completely
automated: real human beings
process our request. We can then
request a tunnel be activated for
us, and, optionally, an IPv6 address
subnet. The tunnel is all we need
to access the IPv6 Internet on a
single computer; the subnet is
needed if we chose to connect a
complete local network through
our machine.

For SixXS, the appropriate
software package is aiccu:

sudo apt-get install aiccu

When we have edited
configuration file /etc/aiccu.conf
with the username and password
given by SixXS, we can restart the
service:

/etc/init.d/aiccu restart

and we should then be able to
see the tunnel with the ifconfig
command:

ifconfig

sixxs Link encap:UNSPEC
HWaddr 00-00-00-00-00-00-00-
00-00-00-00-00-00-00-00-00

inet6 addr:
fe80::40:fe00:229:2/64
Scope:Link

inet6 addr:
2001:db8::101/64 Scope:Global

UP POINTOPOINT
RUNNING NOARP MULTICAST
MTU:1280 Metric:1

This one is configured in a
slightly different way than the
Gogo6 version (note the /64
segment, instead of a single host
/128 address), and uses identifier
“sixxs” instead of “tun”.

If things have gone well so far,
either with Gogo6 or with SixXS,
we can now use the IPv6-activated
versions of network tools to check
connectivity, such as ping6 (instead
of ping) and traceroute6 (instead
of traceroute). Other tools, such as
host and ip, work in the same way
both for IPv4 and IPv6. So:

host ipv6.google.com
ipv6.google.com is an alias
for ipv6.l.google.com.
ipv6.l.google.com has IPv6
address
2a00:1450:4001:c02::63

ping6 -c 3 -n ipv6.google.com
PING
ipv6.google.com(2a00:1450:400
1:c02::68) 56 data bytes

64 bytes from
2a00:1450:4001:c02::68:
icmp_seq=1 ttl=51 time=228 ms
64 bytes from
2a00:1450:4001:c02::68:
icmp_seq=2 ttl=51 time=228 ms
64 bytes from
2a00:1450:4001:c02::68:
icmp_seq=3 ttl=51 time=229 ms

Since we now have IPv6
connectivity with the Web, we can
browse IPv6-only web pages. Some
classical destinations to try out
IPv6 are the dancing turtle at
http://www.kame.net (it dances
only if we connect through IPv6),
or the test pages at
http://www.test-ipv6.com or
http://www.ipv6-test.com.

http://www.kame.net
http://www.test-ipv6.com
http://www.ipv6-test.com
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DIFFICULTIES WITH IPV6
AND UBUNTU

We have just set up a dual IPv4
and IPv6 stack; our computer is
connected directly to the IPv4
Internet through our usual Service
Provider, and indirectly to the IPv6
Internet through the tunnel
broker. But if we had not set up or
do not activate the tunnel, our
computer can be in a situation in
which it has a working IPv4
connection, but not so with IPv6.

Ever since most modern
operating systems activate IPv6 by
default, this has given rise to some
confusion. Many programs are
capable of handling dual-stack
access, they prefer to use IPv6 if
possible and if not fall back to
IPv4. But other programs cannot
handle this, which usually ends up
causing delays that annoy the user.
Some programs even complain
about “not being able to connect
to the Internet” - even though a
perfectly good IPv4 connection is
up.

This is now more-or-less fixed
for software on Ubuntu, though
with previous versions it was

sometimes necessary to deactivate
IPv6 at kernel level. One option
was to blacklist the ipv6 kernel
module, as mentioned by Robert
Clipsham way back in number
seven of FCM. Another possibility
with recent kernels is to disable
IPv6 through the proc interface:

echo 1 >
/proc/sys/net/ipv6/conf/all/d
isable_ipv6

However, it should be stressed
that these difficulties should no
longer come up under Ubuntu:
whichever order in which a
program chooses to connect to the
Internet, it should be able to do so
through one route or the other.
Not so in other operating systems,
specially with commercial
software.

WORLD-REACHABLE

ADDRESSES

The nice thing about IPv6 is that
Network Address Translation (NAT)
and private addresses, ubiquitous
in the IPv4 world, are no longer
used. The reason is that since there
are so many public IPv6 addresses
available, it will not be necessary
to re-utilize them many times over
in the form of private addresses
that are not routable through the
Internet.

The corollary is that the
computers we connect to the Web
using IPv6 are directly reachable
from all over the Internet. Nothing
stands between us and the wild
world out there.

This can come out as an

advantage. Consider, for example,
the hoops some of us jump
through in order to reach our
home machines from outside,
while on the road. Or to get into
our work machines from home
(though systems administrators
may frown on this, and rightly so).
With IPv4, we need to open a port
in our router to enable access from
the outside, and activate
Destination NAT (DNAT) to make
packets we actually send to our
router's external address be resent
inside towards a specific PC. And
we must achieve this rather
complex setup while at the same
time taking into account system
security.

With IPv6 and world-reachable
addresses, this is no longer
necessary. If, for example, my
home computer has global address
2001:db8::101 and an Apache web
server running, I can connect to it
directly from outside my home by
simply pointing any browser to the
corresponding URL,
http://[2001:db8::101] . If I set up a
personal mail server, it can also be
directly reached and mail sent to
me from the Web.

But having our computers
directly reachable can also

http://en.wikipedia.org/wiki/MAC_address
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constitute a serious security risk.
So we need to be really careful
about what kinds of traffic we let
in.

To protect my home computer, I
can use my global IPv6 address to
set up a SSH or OpenVPN virtual
private network (VPN). This way,
full communication can be set up
for all protocols through an
encrypted and authenticated
channel. Even if somebody in
between may see my packets as
they pass through, they cannot
decrypt them and view the data
contained within. So we have a
strong argument in favor of
setting up a secure VPN, and
making sure our services can be
accessed not directly from the
Internet, but only through the
VPN.

Naturally, Ubuntu has all the
necessary tools in the repositories,
both for the client and for the
server sides of the VPN. The
corresponding software packages
are ssh-server, openvpn and
network-manager-openvpn –
though, as usual, other possibilities
also exist.

Luckily, the Linux kernel firewall
is also well up to the job, though it

does need to be correctly set up.
The command-line way of doing
this is probably not for the faint of
heart, as it is relatively easy to
leave out a rule and make things
too easy for the bad guys—or
being over cautious and
inadvertently blocking yourself
out. So a GUI tool such as
firestarter may be a wise choice to
begin with.

If we set up some services we
wish to share with friends—or just
use for ourselves—we should also
bear in mind the security
implication of having a port open
to the world. Special attention
should be given to securing access,
especially when sensitive data can
be accessed, e.g. though file
sharing. If all we want is access to

our files while on the road, SFTP is
probably the easiest service to set
up. Basically, all we need to do is
install package openssh-server on
our home computer. We can then
access it from any file manager
that knows about SFTP (such as
Gnome's Nautilus) using URL
sftp://username@server_ip :

Since SFTP is actually based on
SSH, it may be considered quite
secure, especially if no-password,
public certificate-only access is
used.

For road-warriors, several apps
can be found that do SSH and
SFTP, both for iOS and Android.
Unless, of course, you choose to go
with Ubuntu on your phone or
tablet, in which case finding
suitable client software is simply a
matter of choice.

Alan teaches computer science at
Escola Andorrana de Batxillerat. He
has given courses at the University
and currently teaches GNU/Linux
systems administration at the Open
University of Catalunya (UOC).
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Last month we used Cycles
Render to create the image

shown below left.

Let’s create a similar image
(below right) with the Blender
engine.

The first thing that we notice
(at least me) is shadows. The
shadows that our point lamp casts,
with blender render, are almost
black. This phenomenon is
happening because in Blender
renderer, the light is been emitted
by the lamp only. This isn't
realistic, as in the real world every

object emits or reflects light.

On the other hand, Cycles
renderer calculates the light that
every object has from the
surroundings. You can observe the
cone and see how the shadow
from the cube smoothly fades
(contrary to the cone from the
Blender renderer), and we have a
mirroring ground and a shiny metal
cube in our scene.

One other thing that is very
crucial, and a main difference

between Blender and Cycles, is
more technical.

Navigate to File > User
Preferences > System (above).

At the lower left corner of the
System Tab you can check if your
computer has Nvidia CUDA
support under Compute Device

My GPU has CUDA support so I
can enable it. You can also check it
at the official CUDA support url:
https://developer.nvidia.com/cuda-
gpus

If you are lucky and have an
Nvidia CUDA card, you have to
enable it under the Compute
Device Tab that I mentioned
before AND under the Properties
Panel, Render Tab -> Device -> GPU
Compute in order to have the full
power for your rendering.

https://developer.nvidia.com/cuda-gpus
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Cycles can use your GPU CUDA
cores to render, and is much faster
than the CPU. Check out CUDA at
wikipedia :
http://en.wikipedia.org/wiki/CUDA

If you don't have a CUDA GPU,
you can use Open Shading
Language, but it's a little bit buggy
and I couldn't recommended this
method of rendering, for now. In
the near future I have a feeling
that it’s going to be much faster
than the CUDA render procedure.

But enough with the technical
stuff.

Let’s see another great thing

about Cycles. Open the .blend file
that we started last month, or just
create a new one. Don't forget to
check that the Cycles Render at the
top is selected

Also change one of your 3d view
windows to show the rendered
result.

Select the sphere, navigate to
the Properties Panel and change
the Surface shader from the
default Diffuse BSDF to Emission.

You can check in the Preview
window the cool effect that we
create. You can adjust the Color
and the Strength of the light that
your object emits. Also for every
shader you can adjust a lot of other
things (as textures, for example) by
pressing the little dot right next to
color and strength values.

Select our metallic-looking
cube, press the little dot next to
color, and change its texture to
Brick Texture. Check the result in
your 3d view window and select
different textures until you find
something that you like.

http://en.wikipedia.org/wiki/CUDA
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TIP: The little dots are in every
shader, not only emission, and I
personally find them very useful to
quickly create interesting stuff.

Another interesting shader is
the Mix Shader. As you can easily
understand from its name, this is a
shader that you can use to mix
other shaders. Two other shaders
to be more precise. So, let’s select
our cone and change the Diffuse
BSDF shader to Mix Shader. Add a
Glass shader and a Diffuse shader
or a Glossy Shader and an
Anisotropic Shader to our cone.
Change the value of the Fac
parameter to adjust the
percentage of the second shader
(0.000 means 0% while 1.000
means 100%)

Check the result on your
preview window and adjust the
settings as you like.

Another thing that I want to
mention in this tiny little
introduction on the Cycles
Renderer, is the use of planes
instead of lamps.

Most people working in Blender
and Cycles use planes to illuminate
their scenes. Looks like more “real

world” lighting, and I have no
reason to argue with them.

Below is where I am so far.

For this month, follow this link
http://vimeo.com/68010380 to
enjoy a wonderful work by 3
people and Blender
(congratulations goes to Javier
Trapiella, Baol Bardot Bulsara and
Robert Green).

Also visit www.blendernews.org
to enter and share with thousands
of professional artists!

http://blendernews.org/xe/?mid=F
eature_Articles&document_srl=12
74

mailto:blender5d@gmail.com
http://vimeo.com/68010380
http://blendernews.org/xe/?mid=Feature_Articles&document_srl=1274
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Transparency – or its
counterpart, opacity – is such a

fundamental concept in Inkscape
that it was one of the earliest
topics covered in this series. Back
in Part 3 you were introduced to
the Opacity spin-box on the status
bar, which gives you the ability to
set a single transparency level for
a whole object, or even a group of
objects.

If you want a single object to
have varying opacity – such as
completely transparent at one end,
and opaque at the other – you can
use a gradient for the fill and
stroke. But what about doing the
same for a group of objects? You
could set suitable gradients on
each individual item in the group
separately to get the desired
effect, but if your group contains
lots of objects, then that approach
becomes tedious very quickly.

The solution to this problem is
masking. This is a technique that
uses a grayscale image as a means
of specifying the opacity of
another object or group. Any white
sections in the image cause that

part of the masked object to
appear opaque. Black sections
cause that part to appear
transparent. And grays in-between
result in varying levels of opacity.

Let's look at an example. In this
image (below) I've placed a solid
red circle on top of a solid green
background. The green is there
mainly to show the effect more
clearly. On top of the circle is a
rectangle with a white-black-white
gradient. Using this rectangle as a
mask for the circle gives the result
of a clipped circle that fades from
opaque to transparent and back to
opaque.

Note that anything outside the
mask is clipped. In that respect,
masking could even be used as an
alternative to the clip paths that
were introduced in the previous
part of this tutorial. Draw your
mask entirely in white – or in solid
shades of white and black – and
any parts of the masked object
which lie outside the mask, or
which are colored black, will be
clipped. Usually I recommend using
a clip path in preference to a mask
if you simply want a hard clipped
edge, but, as we will see later in
this article, there are times when
it's easier to use a mask.

You may recall that the fill and
stroke of a clip path are irrelevant
to the final effect on the clipped
object. With masks, however, the
opposite is true – the color of each
individual pixel is taken into
account when calculating its effect
on the masked object, so fills and
strokes have significance.

Did I say pixel? In a vector
format? In practice, there are few
cases where an SVG file is actually
used as a purely vector format. If
you want to display an SVG file on
a computer screen, or print it to an
inkjet or laser printer, it is
ultimately converted to pixels.
Masking takes place during this
final output step, so although the
mask may be made up of vector
objects, and the item being
masked is also a vector, the final
result is really generated only at
the point that those vectors are
converted to individual pixels for
display or printing.

Using a thick-stroked rectangle
and strictly black or white pixels,
it's easy to see the difference
between a clip path and the use of
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a mask to simulate clipping. In the
top pair of images, I've used the
rectangle as a clip path, and you
can see that the result is aligned
with the center line of the stroke.
The second and third pairs of
images show the rectangle being
used as a mask, with only white
parts remaining and black parts
becoming transparent. It's
especially clear in the last pair that
the stroke has an effect.

By now it should be clear that
clipping and masking are similar
operations, so it's not really
surprising that Inkscape exposes
them with the same user interface.
Just as with clipping, the masking
object must be on top of the object
to be masked, in terms of the z-
index. You then select both items
and choose Set Mask from the
context menu, or Object > Mask >
Set from the main menu. Releasing
a masked object is as simple as
selecting it (it will be described as
“Masked” in the status bar) then
choosing Release Mask from the
context menu, or Object > Mask >
Release from the main menu. Just
as with clip paths, it is possible to
edit masks using the node tool
without releasing them first, but
generally there's little benefit to
doing so as you can edit only the
outline shape of the path, not its
color.

As you've seen, using a
grayscale gradient as a mask gives
you some control over the opacity
of the masked object. You may also
recall that Inkscape offers a
selection of black and white
patterns in its Fill & Stroke dialog,
plus a few grayscale bitmap fill
patterns. These may previously

have seemed rather limiting, but
their monochrome nature makes
them perfect for use as a mask.

The checkerboard pattern is a
good example of a situation where
it's easier to use a mask than a clip
path. This same effect could be
achieved by clipping with a
complex path, but it's probably not
worth the extra effort. Looking
closely at the checkerboard, you'll
notice that the fill isn't made up of
black and white squares, but rather
white and transparent. Using white
and transparent can sometimes

make it easier to see what parts of
an object you are masking: white
areas will remain visible, and
transparent areas will be clipped. A
translucent white area will have
the same effect as a shade of gray.
It may seem counter-intuitive to
cover the parts of the object that
you want to keep, and expose the
parts that will be hidden, but that's
the way that masking has been
defined in the SVG specification, so
that's the way it works in Inkscape.

Because clip paths are defined
by a boundary and a concept of
what's inside and outside that
boundary, it's possible to use only
a single path or object to define a
clipping shape. Masks, on the other
hand, are concerned with only the
color of pixels, so it doesn't really
matter whether your mask is made
up of a single object or a whole
load of objects inside a group. This
allows you to create complex
arrangements of colors and
patterns which would be
impossible to reproduce using a
single path.

This example uses a group
made up of a few random objects
as a mask. You can see that the
repeating radial gradient of the
rectangle, made up of a white-to-
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Mark has been using Linux since
1994, and uses Inkscape to create
two webcomics, 'The Greys' and
'Monsters, Inked' which can both be
found at:
http://www.peppertop.com/
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transparent transition, results in a
similar pattern being visible from
the masked red circle. But by
adding extra black and white
features to the mask group, you
can “override” the pattern with
explicit sections of transparency
and opacity. One thing to note is
the place where the black line
crosses the white one: because the
black line is on top, the pixels at
that position are black, so that part
of the masked object is
transparent. It doesn't matter
what's going on within the group,
all that matters is the color of the
final pixels. This may not be the
best piece of abstract art in the
world, but it would have been a lot
harder to draw without using
masks.

Although you can use masks to
create complex arrangements of
clipping and transparency,
probably the most common use is
simply to add “feathering” to the
edges of a group so that it fades
into the background. In that case
all you need for your mask design
is a strongly blurred white ellipse,
as demonstrated in this wholly
unseasonal greeting card design.

Throughout this article I've
referred to masks as being
grayscale images. That's not
strictly true – a mask can be any
combination of colors that you
want. However, anything other
than white, black or gray will be
converted into a grayscale image
before it's used as a mask. This can
make it difficult to predict the

exact effect of a color on the
resultant opacity, so I recommend
using pure grayscales when
drawing your masks in almost all
cases.

http://www.peppertop.com/
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HHOOWW--TTOO
Written by Ronnie Tucker WWrriittee FFoorr FFuullll CCiirrccllee MMaaggaazziinnee

GUIDELINES

The single rule for an article is
that it must somehow be

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc).

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.

• For advice, please refer to the
Official Full Circle Style Guide:
http://url.fullcirclemagazine.org/7
5d471

• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND
GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

document.

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

• Do not use tables or any type of
bold or italic formatting.

If you are writing a review,
please follow these guidelines :

When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS

If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.

REVIEWS

GAMES/APPLICATIONS
When reviewing games/applications please state clearly:

• title of the game
• who makes the game
• is it free, or a paid download?
• where to get it from (give download/homepage URL)
• is it Linux native, or did you use Wine?
• your marks out of five
• a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:

• make and model of the hardware
• what category would you put this hardware into?
• any glitches that you may have had while using the hardware?
• easy to get the hardware working in Linux?
• did you have to use Windows drivers?
• marks out of five
• a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.

http://url.fullcirclemagazine.org/75d471
mailto:articles@fullcirclemagazine.org
mailto:ronnie@fullcirclemagazine.org
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https://spideroak.com

Get 25% off any SpiderOak package
with the code: FullcirclemagFans
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AASSKK TTHHEE NNEEWW GGUUYY
Written by Copil Yáňez

Hi, everyone! Welcome back to
Ask the New Guy!

If you have a simple question,
and you think Ubuntu Bug #1 is
some kind of flying roach, contact
me at copil.yanez@gmail.com.

Today’s question is:

Q: How do I connect to my
Ubuntu desktop using my
Android phone?

A: Right this way, Mr. Bond! Q
Branch has been working on some
new toys for you. How about this?
It’s a combination martini shaker-
slash-Taser. No? Well, then,
perhaps this combination cufflink-
slash-Taser. Or this, it’s a
combination Taser-slash-Taser. Not
very imaginative, I know. Sorry, sir,
we’re a little underfunded right
now.

Nothing says “I want to be
Daniel Craig or Jennifer Garner”
like accessing your Ubuntu desktop
from your mobile phone. What’s
funny is that if Hollywood were
doing it, there would be multiple

cascading menus and screens along
with some kind of eye-tracking
digital Heads Up Display and
virtual keys you’d have to press in
the air like a methed-out orchestra
composer.

Quick detour: why is it that
every tinseltown movie shows
people working with virtual GUIs
suspended in front of them? I get
exhausted just lifting my hand to
turn off the monitor. Forget about
hacking an enemy server, can you
imagine typing an email on one of
those? Are there NO ergonomics
experts in Hollywood? End detour.

As usual, Ubuntu’s way is easy
and sexy. Not sexy as in actually
sexy. Accessing your desktop
remotely isn’t likely to get you a
date with Halle Berry or Javier
Bardem. But it might impress Miss
Linux Kernel 2013 and keep stray
Luddites from wandering onto
your lawn.

To access your Ubuntu desktop
from your Android phone, you’ll
need the following:

1. An Ubuntu PC (I’m on 13.04) -
make sure it’s connected to your
home network
2. An Android Phone (I used an HTC
Droid Incredible II running
Gingerbread)
3. Someone to shout “Hallelujah!”
when you’re finished (this is key,
people, don’t skimp)

Okeedokee, got everything
ready? Good. Go to your PC and
click on the Ubuntu symbol to

open the Unity search field. Type
DESKTOP and you’ll see a Desktop
Sharing application. Click on that
to open it.

Here is how I configured my
preferences in order to give
external access to my Ubuntu
desktop:

The Desktop Sharing window
asks for a password that must be

mailto:copil.yanez@gmail.com
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entered in order for someone to
connect from the outside. Use
something you can easily
remember, like the name of the
gaffer on Star Trek II: The Wrath of
Khan (Romolo Aquistapace, as if
you didn’t know).

You’ll notice I left blank the
“You must confirm each access to
this machine” option. You might
want to keep this box checked. It’s
never a good idea to leave your
machine accessible to the outside
world, even if you’re requiring a
password. I have it toggled OFF for
ease of use, but, honestly, do as I
say, not as I do. And, as a general
rule, you should never take
security advice from someone who
revels in his ignorance.

Oh, if you currently have your
app bar along the left side of your
screen set to auto-hide, change
that to the default so that it’s
always visible. If the app bar auto-
hides, it’s more difficult to access it
from your phone. Also, if you have
your computer set to sleep after a
certain amount of time, you might
want to change this setting so that
your PC doesn’t go to sleep, and
thus disconnect you, in the middle
of a connection.

You’ll also need your desktop
PC’s IP address. Ubuntu makes this
dead simple. Just right-click the
network icon and click on
Connection Information. Note the
IP address listed there, you’ll need
it in just a second.

Okay, now it’s time to get your
phone ready.

Fire up your Android phone and
head over to the Google Play
Store. You’re going to need a VNC
client. That’s the software that will
connect your phone to your PC. I’m
not sure what VNC stands for,
probably just the initials of the

white-haired wizard who captured
this sorcery and gave it away on
the Internet.

I should probably take a
moment to explain what a VNC
client does. But I’m not gonna.
Life’s too short, you know?

The VNC client I used is called
android-vnc-viewer, and it’s free.
Once you’ve downloaded the
software, press the icon to run it.
You’ll see a window with empty
fields. Let’s fill those in and solidify
your status as Alpha
Nerd/Nerdette among your peers
(which, if they mainly consist of
villains named Hans with world

domination fetishes, you should
consider ditching).

In the Nickname field, type
something catchy, like Space Wolf
or Super Tramp. You’re being
totally badass right now, your
nickname should reflect this.

Next, type in the password you
set up on the Desktop Sharing
application. Finally, type in the
desktop PC’s IP address. Your
screen should look something like
that shown on the following page.

Ready? Time to see if your
Hallelujah shouter is up to the task.
Also, if there are any annoying
neighbors who keep trying to
explain fantasy football to you,
invite them over. Payback time!

Click Connect. Hallelujah! Feel
free to lift your arms up Moses
style and scream “Behold!” In a few
moments, your smartphone screen
will fill with a lower resolution
version of whatever is on your
desktop screen. Your phone’s
screen will now act like a laptop
trackpad. Wherever you move your
finger, your cursor follows. Tap the
screen on an Ubuntu app icon and
watch it open.

ASK THE NEW GUY

http://shop.canonical.com/index.php?cPath=17
http://www.ubuntu.com/download/desktop
http://www.ubuntu.com/download/alternative-downloads
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Copil is an Aztec name that roughly
translates to “you need my heart for
what again?” His love of women’s
shoes is chronicled at
yaconfidential.blogspot.com. You
can also watch him embarrass
himself on Twitter (@copil).

Pretty cool, right?

What can you do with this? The
options are endless! You could
access your PC and email yourself a
file you forgot to put into the
cloud. Or click on your webcam and
do a quick security check of your
home office. Or make people
believe you’ve just hacked into a
bad guy’s world domination
system and are shutting down his
nuclear weapons lab with a few
keystrokes. Ladies, you’ll be all the
rage at the next LAN party!

Go ahead, indulge your inner
Sydney Bristow or James Bond.

Good luck and Happy
Ubuntuing!

ASK THE NEW GUY

PYTHON SPECIAL EDITIONS:

http://fullcirclemagazine.org/issue-py01/ http://fullcirclemagazine.org/issue-py02/

http://fullcirclemagazine.org/python-
special-edition-issue-three/

http://fullcirclemagazine.org/python-
special-edition-volume-four/

http://fullcirclemagazine.org/python-
special-edition-volume-five/

http://fullcirclemagazine.org/python-
special-edition-volume-six/

http://yaconfidential.blogspot.com
https://help.ubuntu.com/community/BootFromCD
http://fullcirclemagazine.org/issue-py01/
http://fullcirclemagazine.org/issue-py02/
http://fullcirclemagazine.org/python-special-edition-issue-three/
http://fullcirclemagazine.org/python-special-edition-volume-four/
http://fullcirclemagazine.org/python-special-edition-volume-five/
http://fullcirclemagazine.org/python-special-edition-volume-six/
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LLIINNUUXX LLAABB
Written by Charles McColm DDVVDD MMeennuuss wwiitthh DDVVDDSSttyylleerr

Video is everywhere these
days. Our phones, tablets,

digital cameras and notebooks all
have video capable cameras in
them. Whether you’re taking a
family video or producing a
documentary, it’s nice to put some
polish on the video. There are a lot
of video editing tools for Linux:
Lives, Cinelerra, OpenShot, Pitivi,
and Kdenlive to name a few. These
editing tools will help you put the
polish on your actual video, but
what do you do about creating a
polished looking DVD menu?

In FCM#73, I mentioned
DeVeDe and KMediafactory.
DeVeDe is great for creating
simple menus if you’re in a hurry,
but menus look text heavy.
KMediafactory was great at one
time, but it hasn’t been developed
in several years and the templates
are limited. Enter DVDStyler.
DVDStyler is a cross-platform free
DVD authoring application for the
creation of professional-looking
DVDs.

DVDStyler is available in the
universe repository of Ubuntu and

can be downloaded with a simple

apt-get install dvdstyler

DVDStyler has a number of xine
video-related dependencies.

When DVDStyler starts, it
prompts you to create a new
project or open an existing project.
If you create a new project, you’ll
want to adjust some of the project
title, DVD size, video quality, video
format, aspect ratio, and audio
format for your region. In North
America we use NTSC. I chose the

16:9 rectangular aspect ratio and
stuck with the default AC3 audio.

Next you’re shown a number of
templates and asked to select a
template. You can choose a
template or simple click the no-
template button. There are a
selection of backgrounds on the
left hand side to choose from, but,
by right clicking in the blank space
and selecting properties, you can
choose your own image and audio
track for the menu. If you select an
audio track, be sure to click the

loop check-box to have it play
more than once (you, too, can have
that eventually annoying repeating
music track that seems so cool
when you first hear it).

Once you have your background
and audio track, it’s time to add
some content. In this instance, I
kept it simple and added two
videos by clicking on the File
Browser tab on the left side and
dragging two videos to the menu
page. To add text beside the
videos, right-click near the videos,
select add, then select text, and
type in the text (Sintel for
example). Once the text is on the
page, you can select it and change
the text properties including font
size, style, fill, outline color, outline
size, background color and
location.

I wanted an option to play both
videos back-to-back, so I added a
button from the buttons tab on
the left. I changed its properties by
right-clicking on the button,
selecting properties, then clicking
on the Play all titles check-box.
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LINUX LAB
Buttons need not be tied to

videos. You can also add sub-
menus by clicking on the DVD
menu option then clicking add and
menu. This creates a second menu
which you can link a button to by
choosing menu 2 (in the image
above I just have one menu called
Menu 1) from the Jump to drop-
down dialog (instead of title 1 in
the example illustrated). Sub-
menus can be used to create a
menu for chapters, subtitles or
audio.

A good example of how you
might use a second menu is if you
want to provide a menu for
specific chapters of a video. Don’t
worry if your video is one long
video, you can create chapters by
right clicking on the video (title 1
for example), selecting properties,
and entering the time for the
second, third, fourth, etc. chapters
in the chapters field.

In the buttons along the left
hand side, there is a square blank
button above an elliptical blank
button. The square button displays
an image once dragged to the
menu space. On the second menu,
drag out enough square buttons to
match the chapters you’ve created
(remember chapter 1 usually starts

at position 0 in the video, so,
although our screenshot shows 5
times, we have 6 chapters). Add
text below or beside each chapter.
By default, all the square buttons
will be linked to chapter 1. To
change this, right-click on each
square button, choose properties,
and from the Jump to drop-down,
select the correct chapter for each
button. Don’t forget to add a menu
button and link it back to menu 1
(our top/main menu). With a little
work you can get some neat
results.

DVD Styler is a great program,
but, during the making of several
menus, I bumped into a few
problems. First, text appears to be
limited to 10 characters. Second,
although I was able to resize the
video buttons, the ‘keep aspect
ratio’ button didn’t work as
expected and seemed to squish
the video buttons so they didn’t
look correct. Although it’s not a
problem, it would be nice to have
guidelines in addition to the grid
option.

When you’ve imported all your
videos and created all your menus,
click the File, then click Burn DVD
and OK to make an ISO image of
your DVD. Use Brasero, XFBurn or
K3b to burn the ISO to DVD.

If you’re feeling particularly
adventurous, and are not afraid of
a little XML, you can even create
your own buttons for DVD Styler. A
guy named Mike created a detailed
blogger post about how to add
your own buttons to DVD Styler
here:
http://mikesgeneralblog.blogspot.
ca/2006/08/creating-new-buttons-
for-dvdstyler_04.html

You can find the DVD Styler
documentation and other links on
the DVD Styler web site at:
http://www.dvdstyler.org/en/

Happy DVD menuing!

Charles is a step-father, husband,
and Linux fan, who hosts a not-for-
profit computer refurbishing
project. He maintains a blog at:
http://www.charlesmccolm.com/

http://www.charlesmccolm.com/
http://mikesgeneralblog.blogspot.ca/2006/08/creating-new-buttons-for-dvdstyler_04.html
http://www.dvdstyler.org/en/
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MMYY SSTTOORRYY

It has been about 6 years since I
took my first dive into the ocean

of open source. The first open
source operating system that I was
introduced to was OpenSolaris. I
was very eager to know about
Linux and Unix systems when I was
completing my 11th standard in
high school. (In India, graduation
starts after 12th standard.) Until
now, I was mastering in Installation
& Troubleshooting of Windows. I
loved to fix my friends' systems as I
am crazy about operating systems.

I love to have a challenge, find
solutions to problems, fix systems,
and try new things. I was well
known in my school days and
college days among classmates
and senior students for having IT
skills. In the first year of my
engineering at Government Eng.
college, Dahod, I loved to stay in
the internet lab till it closed. Once
my head of department professor
found out about my IT skills, he
gave me the responsibility to
maintain the system health of all
computer systems in the Internet
lab. As a reward, I got systems for
testing and trying out new things.

At that time, internet connections
were very limited to a few colleges
and enterprise organizations, and
there were slow and unstable dial-
up connections.

I was looking for an operating
system more powerful than
Windows. At that time in India, the
word “Linux” was heard by a only
few IT geeks. Linux was used rarely
in giant enterprises in India. I tried
out OpenSolaris, but I didn't find it
better than Windows.

In September 2009, I came
across the Ubuntu website while
Googling about Linux. Ubuntu was
different than what I had heard
about other Linux distros. I found
Ubuntu more user friendly than
any other Linux distro—with a nice
GUI and powerful security
features. I began to gather more
and more information about
Ubuntu. Due to the slow and
unstable internet speed (max
download speed 15 kbps) at that
time, I could not download Ubuntu
9.10. It would take 3 to 4 days to
download it, and bandwidth was
also costly at that time.

Around October 2010, when
Ubuntu 10.10 was launched, I
decided to download Ubuntu 10.10
anyhow. Internet speed was good
enough but there weren't stable
internet connections yet. We could
hardly download up to 150 MB per
day. After downloading 5
consecutive days with a mobile
dial-up connection, I downloaded
Ubuntu 10.10 successfully on my
friend's desktop. We tried to make
a WUBI installation, but failed. I
decided to install Ubuntu by
creating a new partition and have a
full installation. Finally, I got
Ubuntu installed within just 20
minutes on a P4 with 512 MB RAM.
This was my first installation of
Ubuntu. I had seen Ubuntu just in
screenshots before. Within 3 days I
explored the whole system. My
friend was confused about how to
use the system, but I taught him
Ubuntu. My friend was very happy
with Ubuntu because now he had a
virus-free system with all required
software preinstalled. We got
every device working with Ubuntu
from a camera to 3G modem
without installing any additional
drivers. My whole computing world

changed. I was entering the world
of Ubuntu.

In November 2010, I assembled
my own desktop with Core i3, 2 GB
RAM, 500 GB HDD, and Ubuntu.
Many questions arose in my mind:
How is Ubuntu being developed?
How do contributors work
together? What does this
wonderful system consist of? After
spending some weeks on the
Internet, I got my answers. I
checked out the whole Ubuntu
history and came across the
Launchpad platform, Ubuntu
forums, wiki, and Ubuntu
documentation. I was also
introduced to other Ubuntu
derivatives like Backtrack, Linux
Mint, and Linux Deepin.

Ubuntu proceeded with 11.04
Natty, 11.10 Oneric, 12.04 Precise,
12.10 Quantal. I have enjoyed
every Ubuntu distro and never had
faced a problem during
installation. For the last two years,
Ubuntu has grown and improved a
lot. After the launch of Ubuntu
11.10 Natty, many users didn't like
Unity, but I never faced any

Written by Ketan Patel
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MY STORY
problem with it. Unity became
stable in 12.04 and fixed problems
with other users also. I joined
Askubuntu in April 2012 and have a
good reputation there.

As a student of Electronics and
Telecommunication Engineering, I
was interested only in the
telecommunication part and have a
keen knowledge of technologies in
my field. Now I am interested in
Linux servers as they are a core
part of telecom networks and IT
Enterprises. I decided to learn
about Linux servers and move
towards system administration. I
came across many Linux server
distros like Red Hat, Fedora,
Gentoo, Arch Linux, Centos and
Debian. Most of all I love to work
with Ubuntu Server and Debian.

It took time to learn about
servers due to a busy engineering
schedule. During the time, I
remained connected with the
Ubuntu world using newsletters
and news sites like Omgubuntu
and www.ubuntu-news.net. In time
I came across FCM. I downloaded
previous issues. After that, every
month I download FCM and never
miss a single issue. I introduced
lots of friends to Ubuntu by
installing on their laptops and

desktops.

In December 2011, after
completing my 7th semester exam,
I started my journey with Ubuntu
Server. Within some months I self-
learned Ubuntu Server. I also got
command of Red Hat, Fedora and
Centos. Currently I am working as a
Linux System Administrator in an IT
organization at Surat, Gujarat,
India. Thus, Ubuntu has played an
important part in changing my life
and showed the way to my career.
The Voyage has been just started,
we have to build Cloud Computing
platforms within a few months.

LIBREOFFICE SPECIAL EDITIONS:

http://fullcirclemagazine.org/libreoffice-
special-edition-volume-one/

http://fullcirclemagazine.org/libreoffice-
special-edition-volume-two/

OTHER SPECIAL EDITIONS:

hhttp://fullcirclemagazine.org/scribus-
special-edition/

http://fullcirclemagazine.org/ubuntu-
development-special-edition/

http://fullcirclemagazine.org/virtualisat
ion-series-special-edition/

http://fullcirclemagazine.org/libreoffice-special-edition-volume-one/
http://fullcirclemagazine.org/libreoffice-special-edition-volume-two/
http://fullcirclemagazine.org/scribus-special-edition/
http://fullcirclemagazine.org/ubuntu-development-special-edition/
http://fullcirclemagazine.org/virtualisation-series-special-edition/
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Full Circle Podcast
Episode 34,
Raspberry
Jamboree 2013

Your hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark
and Freaky Clown

from the Blackpool (UK) LUG
http://blackpool.lug.org.uk

Welcome to the first of a 2
part conference special, in
this episode the presenters
reflect on the first ever
Raspberry Jamboree held at
the Manchester Central
Conference Centre on 9th
March 2013

MMYY SSTTOORRYY

Several years ago I purchased an
Acer Aspire One ZG5 for the

relative bargain of £85. It served
me well as a netbook for a couple
of years, I replaced the default
Linux Operating System with
Ubuntu 10.10 Netbook edition and
enjoyed using it. System resources
were relatively sparse having an
Intel Atom 1.6GHz processor,
512MB RAM and an 8MB Video
card. However, courtesy of severe
butterfingers, I managed to break
the screen. I could have replaced it,
but this would have cost me half of
the original purchase price of the
machine, and I had a Dell Latitude
E6400 laptop to use while
travelling, so the netbook simply
got filed away in a drawer for a
few months.

After around 6 months, I
decided to reboot the netbook
using a TV as a monitor, to see
whether it still worked at all, and it
did! I had a spare 1GB memory chip
lying around from a previous PC
upgrade, and decided to install
that into the netbook, to see
whether performance improved. It
did, but things still weren't

lightning fast. I had heard about
XBMC previously, and installed it.
Even with the extra memory, the
whole system seemed slow. I was
aware of Ubuntu derivatives such
as Lubuntu, Kubuntu and Xubuntu,
and decided that I would install
one of them to see hot much
better things were.

I opted for Lubuntu 12.04,
installing from a USB CD drive as I
has trouble encouraging my
machine to boot from USB stick.
Once Lubuntu was installed, I
connected via ethernet to the
adjacent router, and installed
XBMC 11.0, and selected a few
plugins for XBMC, the iPlayer
plugin being of the most interest
to me. I also installed the Quartz
skin as I knew that this was a
lighter skin than the default.

The install was flawless, and
before long I was experimenting
with the plugins, some of which
were more polished than others. I
purchased a Microsoft branded
Wireless keyboard and mouse, and
these were simply plug and play, as
was a USB infra-red remote control

purchased from ebay for £3. This
little netbook has been quietly
soldiering on in this arrangement
for the last 6 months. I have set it
up so that I can now stream audio
and video from a shared drive in
the house, and have even used it
for a barbecue party in my garden.

Because of the very limited
hardware of this machine, it would
be unrealistic to expect super High
Definition at all times, but I can
stream video from almost any data
source. Spotify for Linux works
without issue. Video is connected
via VGA to my television, and audio
via phono cable to our surround
sound. If there is ever anything
that we would like to play that
XBMC cannot handle, we can
simply launch Chromium and play
via the browser.

On paper, this little netbook
ought to be almost useless, but,
for the princely sum of £20, I have
resurrected this little workhorse,
and it is now at the centre of my
family's viewing experience.

Written by Andrew Tatton

http://blackpool.lug.org.uk
http://fullcirclemagazine.org
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RREEVVIIEEWW
Written by Devyn Collier Johnson CClleemmeennttiinnee

Clementine is a popular music
player for Ubuntu systems.

This music player makes a great
alternative to Rhythmbox and
Banshee. Clementine has many
great features and abilities as well
as a nice layout. It is not only a
music player but a music manager.
Clementine allows users to edit
tags, create and edit playlists, and
convert (transcode) music.
Clementine can even retrieve cover
art and missing tag information.
With Clementine, users have a
choice between using the
application through the app
indicator or as a full window.
Clearly, Clementine is a flexible
and multi-functional music
manager that many Linux users
may want to try because of its
many features.

The latest version, at the time
of writing, is version 1.1.1. This
version is very stable. For example,
Clementine does not crash or
freeze; the program completes
tasks successfully without issues.
In my opinion, Clementine is much
more stable than Rhythmbox and
Banshee. The program starts up

quickly when executed, and closes
swiftly when closed. Clementine
does not require any loading when
performing many tasks. However,
Clementine does require some
time to convert audio files,
download cover art, rescan music
libraries, or lookup tag info. These
tasks require time because
converting is a complicated
process, networks have limits to
their speed, and the library must

be created and indexed carefully.

Clementine allows users to
control the player with the
keyboard. For instance, I can press
F7 to stop the music and F10 to
make it louder. This allows users to
perform one task without needing
to switch windows to control
Clementine. Many music players
like Smplayer, VLC and Mplayer do
not support this feature.

Clementine responds to these key-
commands without delay.

The program's layout and
graphics are set up wonderfully. To
the left, users will see their music,
Internet radio stations, artist info,
song info, and search results –
depending on the clicked icon on
the far left column. To the right,
users will see the playlist contents.
Clementine displays the different
playlists as tabs. Just as web
browsers like Firefox permit users
to have multiple tabs with a
webpage in each, each playlist is a
tab. At the bottom of the playlist
box, users will find the controls for
current playing music and the
progress bar. In the bottom left
corner of the application, the
cover-art is displayed with the
music title. The icons and buttons
are carefully placed to provide a
compact appearance. This gives
the playlist and library box more
room to list the music files.

Clementine can be used as a tag
editor. If a user has an mp3 file
that does not have the information
about the artist or genre,

http://www.htc.com/www/smartphones/htc-one-s/#specs
http://nostarch.com/gimp
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Clementine's tag editor will help.
After a user right-clicks the music
file to be edited, they can click
“Edit track information”. This
causes a window to appear with
two tabs. After clicking the tab
titled “Edit tags”, the user will see
the tags that can be edited. If the
user is unsure about what
information should be typed into
the tags, they can click “Complete
tags automatically” to make
Clementine search the Internet for
information. This ability would
work only with music made by well
known musicians and not
individuals that post home-made
music free on the Internet.
Clementine can gather tag
information only if online
databases list the song.

Playlists are easily created and
exported with Clementine. The
first step is to right-click a song in
the left box when “Files” or
“Library” is highlighted. Then,
select “Open in new playlist”. For
the songs that come next, right-
click and select “Append to current
playlist”. After that, right-click the
playlist's tab and click “Save
playlist”. To finish exporting the
playlist, pick a playlist format and a
save location. Once chosen, click
“Save”. Clementine makes this

process very easy. Other playlist
creators can be difficult or time-
consuming to use. Clementine
allows users to save the playlist in
numerous formats. Many playlist
makers do not have a collection of
choices as large as Clementine's
list of formats. This allows users to
easily make a playlist to use with
any device or music player
program.

Clementine
has another
feature that
makes it a
powerful
application:
converting
audio.
Clementine
can convert
between a few
formats. The
conversion window can
be opened by clicking
“Tools” in the menu bar and
selecting “Transcode Music”. Next,
click “Add” to pick music files to
convert and configure the options.
The converting feature is very
convenient and easy to use. For
example, the converting window
itself is self-explanatory.

Clementine even has a moodbar

and a large variety of color sets. A
moodbar is a colored progress bar
used instead of the plain default
progress bar. However, a moodbar
is not just a colored bar. The colors
are based on the “mood” of each
section of the song. The different
color sets are alternate colors used
to display each mood. To
understand what a strip of the
song is like, it helps to know what
the color means for the active
mood color set.

The Internet radio works very
well. Clementine provides

users with a large
selection of radio

stations for any
genre of music.
The collection
is not sparse;

even Icecast
alone is

extensive.
Clementine has no

difficulties playing Internet radio
stations. The sound quality is
superb and clear, and the loading is
swift. It seems as if the music is
coming from local files.

Clementine has an extensive list
of visualizations. They can be
found and activated by clicking
“Tools > Visualizations”. The

window that appears contains
options for the visualizations.
Users should be able to find the
perfect visualization that they
enjoy viewing while listening to
music. The visualizations have a
clear, sharp appearance. The
moving images are not blocky or
pixelated.

These many features make
Clementine a great music manager.
This is a powerful music player that
still retains excellent performance.
This application can satisfy the
needs and wants of many users
while still being easy to use. The
program is pleasing to the eye and
does not require time to figure out
the layout. If users decide to try a
new music manager, or they dislike
Ubuntu's default music manager,
Clementine may be a player that
they may wish to try.
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SSOOFFTTWWAARREE SSHHOOWWDDOOWWNN
Written by Tushar Bhargava PPDDFF VViieewweerrss

In this article I want to tell you
about two Linux native, open

source PDF viewers that can match
almost all of their Windows
counterparts (and have quirkier
names too!).

THE CONTENDERS

If you use Ubuntu, you must
have come across Evince (below
left)—if not necessarily by that
name. The rather sterile sounding
Document Viewer that Ubuntu
ships with is also known as Evince.
According to Carlos Gracia
Campos, the current project lead,
Evince was,”created by Red Hat to

provide a consistent way to read
any kind of paginated documents”.
Evince's tagline reads—”Simply a
Document Viewer.”

Okular (below right), KDE's
counterpart to Evince, however,
came into being from KPDF—as
the name suggests a KDE PDF
viewer. The change of name to
Okular was both logical and
pragmatic. When I asked Albert
Astals Cid, the project lead, about
the switch, he told me,”KPDF 'has'
to be a PDF viewer because of the
name, while Okular not so; we
could support more file formats
like we do now.” Indeed, Okular's

tagline proudly boasts that it is
“More than a reader.”

So, Evince and Okular, though
part of the same large family that
is FOSS, are driven by starkly
different philosophies. However,
do these philosophies actually
dictate the development? Or are
they merely descriptions of the
team's vision? I decided to fire up
both and load the same document
(incidentally a back issue of FCM)
to find out more.

THE USER INTERFACE

The screenshots below show

the file opened in the two
different readers.

At first glance, some things are
evidently clear. Evince—which
belongs to the GNOME project—is
perfectly at home in Ubuntu. It has
Global Menu support and its
appearance compliments the
Ambiance theme on my setup. The
menu bar is simple and intuitive, it
includes up and down arrows for
navigating the document. The
current page number and total
number of pages are also
shown—they help you get your
bearings and are useful in large
documents. The other important

http://www.htc.com/www/smartphones/htc-one-s/#specs
http://nostarch.com/gimp
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SOFTWARE SHOWDOWN
option included is the “Zoom”
percentage. “Fit Page Width” and
“Best Fit” are handy options that
save you the effort of estimating
the right percentage. The menu
bar also has an option to show the
parent folder to which the
document belongs, which can be
surprisingly useful for certain use
cases (eg: browsing the FCM
archive on my hard drive).

Evince has a two-column UI, the
first column is extremely
unobtrusive and the focus is
clearly on the
document—extremely clever
design. The first column though
serves an important purpose other
than just thumbnails, it also shows
the bookmarks and annotations
(you have to select these from a
drop-down menu).

Now to Okular. A perfunctory
glance at the screenshot and you
would think that Okular acquits
itself well in strange waters (it's
part of the KDE project,
remember). Sure, the UI isn't as
elegant or as simple as Evince's UI,
but it’s still fairly straightforward.
The navigation bar has the
standard “previous” and “next”
buttons, a small difference from
Evince—they're horizontal. And

that tiny detail makes a significant
difference, somehow browsing
doesn't seem as intuitive as it did
on Evince. The rest of the items on
the navigation bar more or less
match Evince's. There's a “Zoom”
option with “Fit width” and “Fit
page.” An added advantage are the
simple “Zoom in” and “Zoom out”
buttons that allow you to
circumvent the percentage
dilemma and simply go on clicking
till you're comfortable. There's a
“Browse” button that doesn't do
much in particular. There's also a
“Selection” tool that is simply
awesome. But more about that
later, let me first complete the UI
description.

Okular's UI can be referred to
as a three-column interface. The
first column has four
buttons—”Contents,”
“Thumbnails,” “Reviews” and
“Bookmarks.” Choosing one of the
four determines the contents of
the next column, which, uhh,
shows the thumbnails, bookmarks
or annotations. The final column
shows the document, again it's
larger than the other two but
perhaps places slightly less
emphasis on the document than
Evince. Having said that, the three-
column view has its advantages—it

makes accessing annotations and
bookmarks much easier, avoiding
the drop-down complication of
Evince.

PERFORMANCE

Just as we shouldn't judge a
PDF by its cover page (sorry but I
love bringing familiar sayings to
the 21st Century), we can't be
satisfied merely by analyzing the
GUI of both Evince and Okular. The
question is how do they perform
with a large, picture-filled PDF file
like an FCM edition? But, before I
answer that question, a short
detour.

Okular, under “Settings,” has an
option called “Configure Okular.”
And under that there is a
“Performance” tab. And in that tab
lies Okular's hidden (literally)
ace—memory usage modes. You
can choose “low” memory usage if
your machine is slow, “Normal” is
the default. But if your computer is
fairly modern and has RAM greater
than 512 MB, choose “Aggressive.”
Congratulations, you now have a
PDF reader on steroids. In the
comparison that follows my Okular
was in “Aggressive” mode.

I loaded FCM, edition #63. I
then started browsing rapidly.
Evince didn't much care for my
style of reading, after a few pages
it would show blank pages and
display a rather apologetic looking
yellow loading sign, accompanied
by a spinning progress wheel. The
delay was only a few seconds, but
irritating nonetheless. In sharp
contrast, Okular on opening the
PDF informed me in a business-like
gray message box that it had
loaded the 59 page document. And
it really had. I could browse
through as fast as I wanted. The
searches in Okular were sniper like,
Google-esque—super accurate and
super fast. It managed to find my
name in the magazine (sorry for
ego surfing) literally within
seconds.

ANNOTATIONS AND OTHER

GOODIES

Things go downhill for Evince
from here. PDFs are quickly
replacing books and traditional
paper documents; you want to be
able to make annotations on them.
Evince scored very poorly in this
category. The only annotation
possible is adding a small note.
And in case you typed that note
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wrong, you can't delete it. Yes you
heard me right, Evince informs you
that it can't delete annotations as
of now. In a nutshell, it is simply a
document viewer.

Okular, on the other hand,
really is more than a reader. Its
annotation tools prove that its
boast was not an empty one. Press
F6 or “Review” under “Tools,” and a
plethora of icons shows up on the
left-hand side of the document.
Each icon depicts an annotation
operation. You can make a note,
make an in-line note, draw
freehand, highlight, make ellipses
and rectangles, and even put a
stamp (Okular logo with your
name) on the document. Further,
the “Selection” tool in the
navigation bar makes selecting
text or images a snap. After you
select them, you can either copy to
the clipboard or directly save them
in a file. It works flawlessly and is
one of the most efficient ways of
extracting data from a PDF that I
have seen so far.

Both document viewers had a
“Presentation” mode that would
certainly come in handy, Evince's
offering was again a tad better
designed.

CONCLUSION

In the end however, there can
only be one default PDF viewer.
And that is Okular! Despite
Evince's better, slicker UI, Okular's
superior feature list and blazingly
fast “Aggressive mode” makes it
the PDF viewer of choice for FOSS
fans.

HOWEVER..

Having said that, I would like to
put forward a small addendum.
While interviewing the project
leads of both Evince and Okular, I
realized that the projects share a
close relationship. In fact they
both work together on “poppler”
the PDF rendering library that
powers both viewers.

Mr. Cid told me, “Most of the
'bad attitude' comes from user(s)
than from developers.” While Mr.
Campos pointed out that advanced
annotations may be lacking in
Evince as of now, but only because
of “lack of manpower” and to
remember, “that all Evince
contributors are volunteers.”

Whichever document viewer
you choose, don't forget that a lot

of effort goes into developing and
maintaining both Evince and
Okular. More importantly, both
belong to the FOSS family and
deserve appreciation—no matter
what their shortcomings. Show
your gratitude by dropping them
an email (or even better, offering
to contribute) at okular-
devel@kde.org (Okular) and
evince-list@gnome.org (Evince).

SUMMARY – EVINCE

The Good
• Intuitive, simple and elegant user
interface
• A great professional looking
Presentation mode
• A great guide to using Evince
under 'Help' > 'Contents'
The Bad
• Lackluster performance with
large PDF files
• Lack of annotation features and
the inability to delete a simple
note
• Issues while selecting text, which
the guide itself describes as a hit
and trial procedure
Website -
http://projects.gnome.org/evince/

SUMMARY – OKULAR

The Good
• Efficient and fast performance
especially on a large PDF file
• Amazing annotation options
• Great text or image selection
tool, in fact the best I've ever seen
on any OS
• Extremely powerful searches
especially in the 'Aggressive' mode
• The option to choose memory
management modes makes it
adaptable to computers of all
types
The Bad
• A bit clunky User Interface
• Sometimes the menu options
don't work
• May take up a lot of memory on
GNOME environments as it needs
the KDE dependencies
Website - http://okular.kde.org/

The Winner is: Okular!

Tushar is a 17-year-old Indian who
loves Ubuntu/FOSS. He programs in
Java and C++, enjoys writing, and
making Android apps. Email him at
tushar1995@gmail.com with
'Software Showdown' in the subject.

http://projects.gnome.org/evince/
http://okular.kde.org/
mailto:tushar1995@gmail.com
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LLEETTTTEERRSS
If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org.
PLEASE NOTE: some letters may be edited for space.

DOWNLOAD SCRIPT

One way for people to
download Full Circle is if they

have the downloader script on
their computers. They can use that
to download any issue(s) directly.
I'm doing this right now.

Listed above is the text of the
script, in case people don't have it.

Something to note about this
script. It will download it to the
current directory--regardless of
the cd command in the script. At

least that was my experience. And
the user will have to change the
translation code (en) to whatever
is relevant (if available).

Patrick. Dickey

PYQT

I really liked the Qt Designer
tutorial in FCM#73. I have a good

command over Python, C++ and
Java, but I really don't know much

about creating GUIs. I know you've
covered wxPython and Boa
Constructor, but I'd really
appreciate it if someone does a
dedicated tutorial series on PyQt
or on Qt in general.

Rohan Pinto

Ronnie says: Itmight take a few
months, butGreg is going to look

into it foryou.

Join us on:

facebook.com/fullcircle
magazine

twitter.com/#!/fullcirclemag

linkedin.com/company/full-
circle-magazine

ubuntuforums.org/forum
display.php?f=270

goo.gl/FRTMl

FULL CIRCLE NEEDS YOU!

Without reader input
Full Circle would be an

empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.

See the article Writing for Full
Circle in this issue to read our
basic guidelines.

Have a look at the last page of
any issue to get the details of
where to send your
contributions.

#!/bin/bash
echo -n "What is the issue number of the first Full Circle Magazine to download? "
read firstissue

echo ""
echo -n "What is the issue number of the last Full Circle Magazine to download? (> or =
the previous number) "
read lastissue

cd ~/Downloads/fullcircle # ~ brings you to the home directory of the user and from
there I wanted to use my folder 'Desktop'

for a in `seq $firstissue $lastissue`
do

wget -U Mozilla "http://dl.fullcirclemagazine.org/issue"$a"_en.pdf"
done

echo ""
echo "Complete!"

mailto:letters@fullcirclemagazine.org
http://facebook.com/fullcirclemagazine
https://twitter.com/#!/fullcirclemag
http://linkedin.com/company/full-circle-magazine
http://ubuntuforums.org/forumdisplay.php?f=270
http://goo.gl/FRTMl
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LETTERS
LIBREOFFICE STYLING

I have been using Ubuntu for the
last 3 years and I wouldn’t

change it for anything else. Full
Circle Magazine is a great
magazine to supplement what is
new in Ubuntu.

My job requires me to produce
specialist manuals and the styling
paragraph titles is most important
to be able to refer. Just as an
example, it would be something
like this

1.0
1.1
1.1.1
1.1.1.1

with different font styles and
font sizes. The problem is that I
cannot find a way to save this set
of styles in LibreOffice to be re-
used consistently throughout
various manuals.

While we are in the same
subject would you please
recommend an XML editor that
uses DITA in Ubuntu linux
environment?

Christian Gauci

Greg & Elmer say: ForXML, I use

geditbyhand.

Elmer says: Saving the style to
the default template seems like the

wayto go, buthave nevertriedit.

The answermaybe a template but

not the default template. Iwill look

into it.
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QQ&&AA
Compiled by Gord Campbell

If you have Ubuntu-related questions, email them to:
questions@fullcirclemagazine.org, and Gord will answer them in a future
issue. Please include as much information as you can about your problem.

Q I recently installed Ubuntu on
my system, which has an Asus

M5A99x Evo motherboard, and I
can't figure out how to get the
drivers to work. I'm new to Linux.

A Drivers work very differently
in Linux than what you are

used to. Most drivers are included
with the kernel, so it "just works."
If you have installed Linux and
everything works, you have no
need to chase after drivers.

Since your motherboard is very
new, older versions might not work
as well as 13.04. Even with 13.04,
it's possible some bits won't work,
such as the Ethernet port.

Wireless adapters are a special
case, some just work, some work if
you say the appropriate "shazaam,"
some work after quite a struggle,
and some never work. Webcams
and printers are similar.

My entire system "just works,"
including all of the above, also a
scanner.

Video cards usually just work,

but then you can get better
performance by installing an
"additional driver," which is done
via the Ubuntu Software Centre.

Q In Ubuntu 13.04, how can I get
the background to change

every few minutes, so the
wallpaper becomes a slideshow?

A (Thanks to Maverick Meerkat
in the Ubuntu Forums) Right-

click on the desktop. Select
"Change Desktop Background." A
group of thumbnails will appear,
the upper-left one has a white
clock drawn on it. That is the
background slide-show.

Q Machine is a FitPc3, running
Ubuntu 64-bit 12.04. The new

version of Skype doesn't play nice.

A Install multiarch-support.

Q I'm trying to use WiFi in a
hospital, but the connection

drops every few minutes. I can

reconnect, but then it drops again.

A (Thanks to praseodym and
steeldriver in the Ubuntu

Forums) Sometimes the problem in
'campus' type networks is that
they have multiple access points
sharing the same ESSID. That can
make the wireless device go crazy
trying to roam to the nearest /
strongest access point. Run this
command: sudo iwlist scan

Add the MAC-address of the
nearest access point into the field
"BSSID" in the network-manager
applet. (You'll need to change it if
you move to a different location in
the hospital.)

Q My Ubuntu Server works
great, and now I need to make

a Livecd in order to copy the server
to some other machines with the
same hardware.

A (Thanks to Shrek01 in the
Ubuntu Forums) Hi, have you

met Clonezilla?
http://clonezilla.org/

Q I have a multi-boot PC. When I
installed a new version of

Linux to play with, it became the
grub default. How can I change
this?

A Boot into the version of Linux
you want as your default, then

issue this command:

sudo grub-install /dev/sda

Q In Ubuntu 13.04, my wireless
doesn't work: Broadcom

Corporation BCM4313 802.11b/g/n
Wireless LAN Controller (rev 01)

A (Thanks to chili555 in the
Ubuntu Forums) Enter these

commands:

sudo apt-get remove --purge
bcmwl-kernel-source

sudo apt-get install linux-
firmware-nonfree

Then reboot.

mailto:questions@fullcirclemagazine.org
http://clonezilla.org/
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Q & A

Q I want to be able to rename
multiple files?

A Install gprename.

FROM THE UBUNTU NEWS

DIGEST, ACTIVE AND TOP

QUESTIONS AT ASKUBUNTU:

* Is there a way to restore
Nautilus' split screen (F3) feature?
http://goo.gl/NOzhg

* Dependency error while
installing Google Chrome on
Ubuntu 13.04
http://goo.gl/VQGMA

* Why is the life of Ubuntu 13.04
so short?
http://goo.gl/ceaPM

* Did I just delete everything with
find -exec mv?
http://goo.gl/T7lTo

* Jupiter or similar power saving
app for 13.04?
http://goo.gl/zy4JE

* Does encrypting the hard drive

affect file sync with programs like
Dropbox, Ubuntu One, Spider Oak,
Insync, and others?
http://askubuntu.com/questions/2
95349/

* How do you get an hourly talking
clock for Ubuntu 12.04?
http://askubuntu.com/questions/2
95792/

* How do I set Facebook, Twitter
and GMail accounts in the Ubuntu
13.04 online accounts?

http://askubuntu.com/questions/2
96455/

* Backspace in insert mode in vi
doesn't erase the character
http://askubuntu.com/questions/2
96385/

* Remotely turning on computer?
http://askubuntu.com/questions/2
97198/

* Update available message after
installing update

http://goo.gl/0kgGe

* Desktop shows a white or black
background instead of wallpapers
http://goo.gl/JmI6i

* Where can I look for malware
that may have been installed on
my machine?
http://askubuntu.com/questions/2
98992

* How do I obtain and install larger
mouse pointers - I am slightly

http://goo.gl/NOzhg
http://goo.gl/VQGMA
http://goo.gl/ceaPM
http://goo.gl/T7lTo
http://goo.gl/zy4JE
http://askubuntu.com/questions/295349/
http://askubuntu.com/questions/295792/
http://askubuntu.com/questions/296455/
http://askubuntu.com/questions/296385/
http://askubuntu.com/questions/297198/
http://goo.gl/0kgGe
http://goo.gl/JmI6i
http://askubuntu.com/questions/298992
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After a long career in the computer
industry, including a stint as editor of
Computing Canada and Computer
Dealer News, Gord is now more-or-
less retired.

Q & A
visually impaired
http://askubuntu.com/questions/2
98842

* Does it make sense to create
swap partitions for new
installations nowadays?
http://askubuntu.com/questions/2
99417

* How do I switch between English
and Greek Polytonic?
http://askubuntu.com/questions/2
98708

* How to use wildcards for string
conditionals using bash?
http://askubuntu.com/questions/2
99710

* Run same command again but as
sudo
http://goo.gl/nyMik

* How to sandbox applications?
http://goo.gl/YHz8r

* Does the Ubuntu 13.04 disk
image fit on a CD?
http://goo.gl/6LLbD

* How to post reviews on
apps.ubuntu.com?
http://goo.gl/GStZj

* Can I run Steam as its own

standalone session?
http://goo.gl/xbUjt

* Computer running very slowly
under 13.04
http://goo.gl/TM2Xt

TIPS AND TECHNIQUES
Server? Really?

Almost from the beginning,
people have had the option of

installing Ubuntu Server rather
than Desktop.

Only one problem: you need to
do everything from the command
line, and some things are just a lot
easier if you have a graphical

interface. So what does the Server
version buy you?

For starters, it needs less
memory than the Desktop version.
It also runs faster, and that's
important if you are running a
high-volume website or a busy
database server. Those needs
sound pretty corporate; if you're
installing a server in your house,
it's unlikely that you will need that
little bit of performance.

The cost of a server computer
which can run a GUI is minimal.
Where I live, there are computer
stores which sell off-lease
computers. For example, a system
with an Intel Core 2 Duo, 2 GB of
memory and a small hard drive

goes for $130 -- and it will run
Xubuntu like gang busters. For a
household server, you will
probably want lots of disk space,
so you'll replace the hard drive
with a 2 TB model: $95 gets you a
pretty decent one. We're up to
$225, which is pretty cheap as
computers go.

Running Xubuntu, most of the
system tools you are used to are
right there; you don't need to use
Google every time you want to do
something. You can install
everything which might be part of
a server system, and it all works.
Website? Check. Sharing Files?
Piece of cake. Media server? Yup.
Databases? No problem. Well, no
more than you would expect with
databases.

And yet, I still see questions
which begin, "I'm running Ubuntu
Server, version ..." And I wonder
why.

http://askubuntu.com/questions/298842
http://askubuntu.com/questions/299417
http://askubuntu.com/questions/298708
http://askubuntu.com/questions/299710
http://goo.gl/nyMik
http://goo.gl/YHz8r
http://goo.gl/6LLbD
http://goo.gl/GStZj
http://goo.gl/xbUjt
http://goo.gl/TM2Xt
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UUBBUUNNTTUU WWOOMMEENN
Written by The Ubuntu Women Team

Emma Marshall: Can you tell us
a little bit about yourself?

Diane Leikvold (above): I am
the network administrator,
desktop support, and technology
coordinator at Longmont Christian
School in Longmont, Colorado. I
also teach keyboarding to 4th and
5th graders, and Google Docs to
middle school students and
teachers. My hobbies are biking,
Zumba, camping, being outdoors in
the sun. I have been married for 24
wonderful years to my husband
Kurt, and we have 2 grown boys.

EM: How did you discover

Ubuntu?

DL: My husband introduced me
to Ubuntu in the summer of 2010.
Our school was still using Windows
2000 due to budget constraints.
Since Windows 2000 was losing
support that summer, we were
looking for a replacement. My
husband showed me Ubuntu
during our camping trip to South
Padre Island, and I fell in love with
the operating system, so we made
the decision to convert the whole
school that summer.

EM: How do you use Ubuntu in
your daily routine? Work or
recreational or both?

DL: Both. After I converted the
school, we also converted our
home. I use Ubuntu exclusively in
our home.

At school, I have approx 120
laptop/desktop computers running
Ubuntu. I have two labs, and the
rest are teacher and classroom
machines.

I have also donated laptop

computers installed with Ubuntu
to missionaries in Kenya. There
were a couple of missionaries who
came to the U.S. for a visit at our
church. I spent a whole dinner
telling them about Ubuntu and
how successful it is at our school. I
sent an Ubuntu laptop home with
them so they could play with the
operating system and see if it
would work in their schools. After
introducing them to Ubuntu, they
continue to use it in their
missionary schools there locally. I
continue to send more laptops
with Ubuntu to them as they
become available through
donations.

EM: You recently shared your
success about the Longmont
Christian School transition to
Ubuntu with the Colorado Ubuntu
Team, can you share your success
with the community?

DL: I started teaching
application software in the high
school at Longmont Christian
School in 2000 with 12 computers
throughout the school (nine being
in my lab) with a dial-up

connection. The next year, we
networked the school and doubled
the amount of computers. By 2009
we were up to 63 computers
running Windows 2000. In 2010, I
wrote a proposal and presented
our desire to change to Ubuntu to
the principal of the school. After
gaining his approval, I imaged all of
the computers in the school with
Ubuntu 10.04, wrote training
material for the teachers, and sent
an email out to notify the teachers
of the upcoming changes and
training dates. The week before
school started, I trained all of the
teachers and staff on Ubuntu and
boldly started the year on the new
platform.

I was truly amazed at how
smoothly it went for such a large
change. The teachers embraced
the new operating system and
continue to enjoy using it today.
Through the years, I brought what I
was teaching in the high school
down to middle school and then
elementary. I truly believe that
what we have at Longmont
Christian School is pretty
awesome!
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UBUNTU WOMEN

I have 26 teachers, most were
technology challenged and fearful,
but they all love using Ubuntu and
are doing so well. I have over 120
laptops/desktops dispersed
throughout the school all installed
with Ubuntu. I would love to get
the word out to Canonical and
Boulder County to spread the word
even farther on how Ubuntu is a
great solution.

EM: What influenced you to
take on such a large project?
What's the most rewarding aspect
of the Longmont Christian School
project?

DL: The school was using
Windows 2000 and the support
was up in the summer of 2010. We
needed to upgrade our operating
system, but the school was very
budget constrained, so, with my
husband’s encouragement, we
looked into Ubuntu. The rest is
history.

The most rewarding aspect for
me is how smooth the transition
happened at our school and how
easily the teachers adopted the
new operating system. I am even
able to support teacher curriculum
through Wine in Ubuntu.

EM: If you could influence every
school in the country to transition
their computer labs to run Ubuntu,
what would be your #1 reason to
convince them?

DL: It is easy to use and
maintain. I have found that my
support hours were reduced once I
switched the school from Windows
to Ubuntu. It is very well packaged
and is pretty easy to maintain.

If I could have a #2, the second

would be cost. I use donated
hardware with a zero cost
operating system and zero cost
software. For a small, private
school, this goes a long way to
reduce overall cost of the school
and helps lower tuition for the
parents.

EM: What do you hope to
achieve in the future in your
efforts to promote Ubuntu?

DL: This summer I am planning

on providing free training in
Ubuntu for our parents.

EM: What other Ubuntu
projects/groups are you involved
with?

DL: I supported the Ubuntu lab
at a TIE (Technology in Education)
conference in 2011. I recently
became involved with the Colorado
Ubuntu Users Group as well.

For people looking to get
involved in Ubuntu, who aren't
interested in learning how to code,
what advice can you give to help
them get started?

My advice is to share their
Ubuntu successes with people
around them—to help spread
Ubuntu to a larger community.

EM: Is there anything else you'd
like to add?

DL: Once I started using
Ubuntu, I fell in love with it. It is my
desire to continue to work with
and to promote Ubuntu.
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UUBBUUNNTTUU GGAAMMEESS
Written by Joseph Johaneman

Gratuitous Space Battles is a
space-based RTS made by

Positech Games. It is unusual in
that there is no resource
exploitation, and, once ships are
issued orders, the player has no
control over the outcome of the
battle. This sounds like a simple
concept, but, in execution, the
game is phenomenally difficult at
times.

Players can create their own
ships from the ground up. There
are pre-built ship designs if you
want to use them, but it behooves
you to learn how the ship design
mechanism works. Every empty
hull is a blank slate that allows you
to create ships as fast or as
powerful as you think you'll need.

Each battle starts simply: you
are given a certain amount of
resources and pilots, and can
create a fleet within those
guidelines. Your opponent also has
the same limitations. Once you lay
out your fleet and give orders, you
press the fight button and the
fleet is deployed.

You can watch the battle take
place, but you can't intervene. It's
incredibly fun to watch your ships
follow their orders, and the 2D
graphics are incredibly well done.
At the top of the screen is a
communications panel which
displays messages about the battle
from the point of view of the
pilots. Sometimes these messages
are humorous, and it's worth
looking up to see what's being
said. If you’re impatient, you can
speed the battle up to 4 times the
normal speed.

Each battle is different, and it'll

take a lot of trial-and-error before
you figure out exactly how to
design and deploy a fleet in order
to emerge victorious. For each
victory, you win honor points which
can be used to unlock components
and new playable races. You can
replay battles and win even more
honor by using fewer ships and
pilots.

This game is not for the casual
game player. It requires a lot of
thought and planning in order to
win each battle, especially as the
game advances. Gratuitous Space
Battles is certainly not for

everyone. If you're a fan of
strategy games, though, you
should definitely check it out. My
only complaint about the game is
the repetitiveness. After you
master ship design, the game
becomes easier and easier.

Currently, the Linux version is
available from Steam and Desura
for $14.99. Unfortunately, none of
the downloadable content (DLC) is
available for Linux. (The Positech
Forums do have discussions on
how to make the DLC work in
Linux. Your mileage may vary).

Pros:
Great 2D graphics, fun battles,
decent background music.
Cons:
Repetitive Game Play

GGrraattuuiittoouuss SSppaaccee BBaattttlleess

Joseph is a Comms major at Keystone
College and is the Director of
Technology for Gamers Against
Bigotry. You can follow Joe on twitter
(@dogboi) and find his blog at
jejohaneman.com

http://jejohaneman.com
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LLIINNUUXX CCEERRTTIIFFIIEEDD
Written by Richard Philip Witt

Richard Philip Witt, 30, living in
Switzerland. I’ve been using Ubuntu
desktop and server for roughly 2
years. But only for the basics. Now I
want to discover its capabilities. Any
mentors out there? Email me:
chilledwinston2@hotmail.com.

I'm unemployed, and where I live,
as I think is also the case in a lot

of countries, I need to make a
number of job applications a
month. Now, I’m also the organised
type and I like to keep all my
applications nicely foldered away
in their respective months. Hence, I
have a folder hierarchy as follows:

unemployed --> applications
--> jan, feb, may (it's been
some time now) --> job_name

Now, of course, when I log in, I
arrive in the home directory, and
because of my meticulous folder
architecture :), it takes some time
to navigate to the said month or
even application upon which I'm
working. In the window (point &
click), I have set up a shortcut, but
as I like to use the terminal, I'd like
to set up a link in my home
directory which will jump to the
month where all my current
applications are stored. Now how
do I do that? With a symlink.

WHAT ARE SYMLINKS?

Basically, a symlink is a file

which points to another file.

THE CODE

So we know I need one. We
know what it is, well in theory at
least. Now how do I create one? In
generic terms there are two
possibilities:

Possibility 1: ln [options]
file link

Possibility 2: ln [options]
files directory

The first noteworthy item is
that setting a symlink isn't a
default option for the ln command.
You need to pass -s to the [options]
section, otherwise you'll create a
hard link.

Now to create the link to the
application I'm working on.
Presently it's May and all my
applications are in my May folder
(some of my desktop is organised
in German so it's written Mai). Also
I want to create a link to a folder,
not a file. My first attempt.
Navigate to where I want to place
the link (in my case in my

Documents folder), and type:

ln -s
/home/rpwitt/Documents/unempl
oyed/applications/NPAB_Mai/
new_link

To repeat, '/home/rpwitt/....' is
the location to which I want the
symlink to jump to, and the name
of the link is 'new_link'. Now if I cd
or ls 'new_link', I get the contents
of my NPAB_Mai directory.

EDITING SYMLINKS

Now I only used the name
'new_link' for demonstrative
purposes and also it's not going to
be May for ever. At some point, in
the not too distant future, I'm
going to be sending applications in
another month. So I need to be
able to change the name of my
symlink, and also the location to
which it points. First, change the
name. This is as simple as one
would imagine it might be. Simply
change the symlink name as you
might a filename:

mv new_link may_app

Now I would like to change the
location to which the link points.
Just repeat the code above, but
pointing to a new location:

ln -s
/home/rpwitt/Documents/unempl
oyed/applications/NPAB_Jun/
jun_app

Anyway, I hope that helped, and
if you are a seasoned symlinker or
have just put together your first,
like me, please write to let me
know your ideas. I would love to
hear about how you use symlinks.

mailto:chilledwinston2@hotmail.com
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MMYY DDEESSKKTTOOPP

I use Linux Mint 13 "Maya" Cinnamon (32 bits). I moved my task
bar at the bottom to the top! About the girl in the background,
her name is "Faith" and she is the heroine of the game "Mirror's
Edge" (Link to download the background image :
http://www.jeuxvideo.com/downloads/fonds-ecrans-
wallpaper/images/0001/19294-976-mirror-s-edge-pc-fond-ecrans-
4028.htm)
At the bottom of the screen, I use Avant-Windows-Navigator with
all my favorite applications.

My equipment:
Motherboard: ASUS A8V VM-SE, CPU: AMD Athlon 64 3500+ (2.20
GHz), OS: Linux Mint 13 "Maya" Cinnamon (i386), RAM: 1 GB,
Graphics Card: ATI Radeon HD 4600

Khalif ADAM

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

My netbook:
Model - ASUS Eee PC 1001 PXD
BIOS Revision - 0601 02/18/11
Operating System - Windows 7 and Ubuntu 13.04 (default)
Desktop Environment - Unity
Processor - Intel Atom CPU N455 @ 1.66GHz × 2 (32-bit)
Graphics - Intel IGD
Memory - 2 GB
Hard Disc - 250 GB

Leon Miklosik

mailto:misc@fullcirclemagazine.org
http://www.gothicwalpapers.com
http://www.jeuxvideo.com/downloads/fonds-ecrans-wallpaper/images/0001/19294-976-mirror-s-edge-pc-fond-ecrans-4028.htm
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MY DESKTOP

That’s all folks. I’m all out of My Desktop screens. If
anyone wants to submit their desktop, feel free to
email a screenshot (but no wider than 900 pixels, and
in JPG format) with the appropriate information to:
misc@fullcirclemagazine.org. Thanks!

If you sent a desktop screen and it hasn’t appeared in
FCM then it means you either didn’t submit
any/enough information, or your screenshot was too
large. Feel free to resubmit.

I have been using Ubuntu since 2008.

At the moment I use Ubuntu 12.04 LTS with Gnome Shell
3.4. I modified the stock GUI because I think it is not
practical enough. I used only official Gnome Shell
Extensions (available in https://extensions.gnome.org/).

My hardware:
Lenovo R400,
Processor: Intel® Core™2 Duo CPU P8600 @ 2.40GHz × 2
Graphics: Integrated Intel, Intel Graphics Media
Accelerator (GMA) 4500MHD
Memory: 4 GB
HDD: 160 GB
Display: 1280 x 800

Károly Nagy

https://extensions.gnome.org/
mailto:misc@fullcirclemagazine.org
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HHOOWW TTOO CCOONNTTRRIIBBUUTTEE
Full Circle Team

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy, Lucas Westermann,
Gord Campbell, Robert Orsino,
Josh Hertel, Bert Jerred

Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

FULL CIRCLE NEEDS YOU!
A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471

Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our forum via: fullcirclemagazine.org

FCM#75
Deadline:
Sunday 07th July 2013.
Release:
Friday 26th July 2013.

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with
the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Google Currents - Install the Google Currents app on your Android/Apple devices, search for 'full circle' (within the app) and
you'll be able to add issues 55+. Or, you can click the links on the FCM download pages.

Ubuntu Software Centre - You can get FCM via the Ubuntu Software Centre: https://apps.ubuntu.com/cat/. Search for 'full
circle', choose an issue, and click the download button.

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.

Ubuntu One - You can now have an issue delivered to your free Ubuntu One space by clicking the 'Send to Ubuntu One' button
which is available on issues 51+.

Getting Full Circle Magazine:

mailto:ronnie@fullcirclemagazine.org
mailto:admin@fullcirclemagazine.org
mailto:articles@fullcirclemagazine.org
mailto:podcast@fullcirclemagazine.org
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http://ubuntuforums.org/forumdisplay.php?f=270
mailto:letters@fullcirclemagazine.org
mailto:reviews@fullcirclemagazine.org
mailto:questions@fullcirclemagazine.org
mailto:misc@fullcirclemagazine.org
mailto:mobile@fullcirclemagazine.org
https://apps.ubuntu.com/cat/
http://issuu.com/fullcirclemagazine
mailto:mobile@fullcirclemagazine.org
https://apps.ubuntu.com/cat/
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